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فصل 3

تولید چند رسانه ای

سازمان ها ،  شک  بدون  می زند  را  اول  حرف  اطلاعات  و  ارتباطات  که  جاری  قرن  در 
از  استفاده  دریافته اند  کوچک  مشاغل  صاحبان  و  متخصص  افراد  حتی  و  شرکت ها 
برای معرفی خدمات و محصولاتشان  یا کاتالوگ ها  مانند روزنامه ها  رسانه های سنتی 
برای  بنابراین  است.  رسانه ها  این  پخش  جغرافیای  به  محدود  و  نیست  مؤثر  چندان 
دیجیتالی  ارتباطات  فناوری  از  دارند  نیاز  خود  رقبای  بر  برتری  و  کار  بازار  تصاحب 
جذب  و  خود  تبلیغات  دادن  قرار  پوشش  برای  همراه  تلفن های  و  رایانه ها  بر  مبتنی 
الکترونیکی دارد  نیاز به تولید محتوای  امر  انجام این  مشتریان جدید استفاده کنند. 
که به صورت تعاملی و آموزشی بوده، ضمن معرفی محصول ، امکان تعامل با کاربر برای 
نمایش محصول یا خدمات با توجه به گزینه های انتخابی وی را داشته باشد. همچنین 
باید امکان نظرسنجی از کاربران و دسته بندی پاسخ ها و ارائه آن به صاحبان محصول 
برای اتخاذ تصمیمات مهم را فراهم آورند. لذا در این فصل با 24 واحد کارگاهی هنرجو 
قادر خواهد بود با استفاده از نرم افزارهاي تولید محتوا، بسته های آموزشی و تعاملی 
قابل اطمینان، تولید و نسبت به نشر دیجیتالی آن اقدام کند و شایستگی لازم را در 

به دست آورد. زمینه  این 
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  کاربرد اندازه های متفاوت صفحه در پروژه های چندرسانه ای چیست؟
  چگونه می توان یک محتوای الکترونیکی تولید کرد؟

  چگونه می توان خصوصیات اشیا را در پروژه تولید محتوا تغییر داد؟
  چگونه می توان از بازی های موجود در نرم افزار کپتیویت در پروژه استفاده کرد؟

  چگونه می توان از صفحه نمایش فیلم برداری کرد؟
  چگونه می توان زمان و ترتیب نمایش اشیا در پروژه فیلم برداری را مدیریت کرد؟

 چگونه می توان فیلم تعاملی ساخت؟

هدف از این واحد شایستگی ساخت نشریه الکترونیکی » ایران من « همراه با فیلم برداری از صفحه نمایش 
است.

آیا تا به حال پی برده اید

استاندارد  عملکرد

و  نرم افزار  امکانات  از  استفاده  با  و  کرده  فیلم برداری  نمایش  از صفحه  محتوا،  تولید  نرم افزار  از  استفاده  با 
کند. تولید  الکترونیک  محتوای  مختلف،  رسانه های 

واحد یادگیری ٥ 

    شایستگی تولید محتوای الکترونیک 
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پژوهش

content ـ E ـ1

به تصویر روبه رو با دقت نگاه کنید.
به نظر شما هزینه کتاب های خریداری 

شده در این تصویر چقدر است؟
برای  کافی  فضای  منازل  همه  در  آیا 
و  تصاویر  مجلات،  کتاب ها،  نگهداری 
فیلم های ویدئویی آموزشی وجود دارد؟
آیا در هر زمان و در هر مکان می توان 
به همه این اطلاعات دسترسی داشت؟
چه راه حلی برای این نگرانـی هـا وجود 

دارد؟

محتوای الکترونیک )Electronic content(1 به مجموعه ای از تصاویر، متون، فیلم ها، صداها و پویانمایی ها 
گفته می شود که هدف آن آموزش یک یا چند بخش از محتوای آموزشی یا اطلاع رسانی است. البته می توان 
مجموعه ای از تصاویر، متون و یا فیلم های مرتبط با یک موضوع را جداگانه و هرکدام را به تنهایی یک محتوای 
الکترونیکی به شمار آورد. منظور از محتوای الکترونیکی صرفاً درس افزار نیست. یک نشریه الکترونیکی یا یک 

گزارش الکترونیکی می تواند، محتوای الکترونیک باشد.

درباره مزایا و معایب محتوای الکترونیکی آموزشی تحقیق کنید و نتیجه را به کلاس ارائه دهید.

 چند نمونه محتوای الکترونیکی تولیدی و نرم افزارهایی که در تولید محتوا از آن استفاده کرده اید 
بنویسید.

باید به وسیلۀ معلمان تولید شود ؟ در این باره با هم کلاسی های خود   آیا محتوای الکترونیکی صرفاً 
کنید.  بحث 

 چند نمونه محتوای الکترونیکی که تا کنون با آن کار کرده اید نام ببرید و با هم کلاسی های خود در 
مورد کیفیت آموزشی مطالب و نحوه ساخت آنها بحث کنید. در هر یک از این محتواها از چه رسانه هایی 

استفاده شده است؟

فعالیت
گروهی
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نرم افزار تولید محتوای الکترونیک

تولید  نرم افزارهای  از  یکی  کپتیویت  نرم افزار 
نرم افزار  این  در  است.  الکترونیک  محتوای 
می توان از رسانه های مختلف برای ساخت انواع 
الکترونیکی  محتوای  الکترونیکی،  نشریه های 
آموزشی، انواع آزمون های الکترونیکی همراه با 
کارنامه، و امثال آنها استفاده کرد. این نرم افزار 
قابلیت تایپ فارسی به صورت مستقیم را دارد. 

فعالیت 
سناریوی تولید نشریه الکترونیکی با موضوع » ایران من« را بنویسید.كارگاهي

سناریوی پروژه »درس افزار الکترونیکی آموزش  Snagit« را بنویسید. پروژه

در جدول زیر اعضای متخصص گروه تولید محتوای الکترونیک و وظیفه هر یک را پیشنهاد دهید.كنجكاوي

وظیفهعضو گروهردیف

مدیر پروژه1 

گرافیست2 

مسئول صدا3 

مسئول بررسی صحت محتوا و درستی اطلاعات4 

 5

 6
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روند نمای پروژه » ایران من «
هر پروژه ای قبل از اجرا به یک روندنما نیاز دارد. در روند نمای اصلی، مراحل و ساختار پروژه نمایش داده 
می شود. براساس روندنما، سناریوی هر بخش نوشته می شود. ممکن است برخی از بخش های روند نما نیاز 
به روندنمای فرعی داشته باشد. مدیر پروژه با توجه به زیرمجموعۀ آن بخش، روند نمای فرعی پروژه را رسم 

می کند.

فعالیت 
كارگاهي

پروژه

روند نمای پروژه نشریه الکترونیکی » استان من« را رسم کنید. 

روند نمای پروژه » درس افزار الکترونیکی آموزش Snagit« را رسم کنید. نماهای ورودی، اصلی ، آموزش، 
راهنما، درباره ما، تمرین عملی، سرگرمی و آزمون را در نظر بگیرید. نماهای فرعی را برای اسلاید  آموزش 

نمایشی و آموزش تعاملی در نظر بگیرید .

روند نمای پروژه »ایران من« 

ورودی
)Intro(

صفحه اصلی 
)Homepage(

مشاهیر
ایران من

سروقامتان
ایران من

دیدنی های
ایران من

محیط زیست
ایران من

گالری
ایران من

مدافعان ایران من

اردوهای جهادی

نوروز ایران منآب

سوغات ایران من

در روند نمای پروژه »ایران من«، روند نماهای فرعی را نام ببرید.كنجكاوي
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کارگاه 1 ا  ایجاد پروژه 

فعالیت 
كارگاهي

نـرم افزار  خـود،  هنرآمـوز  کمک  بـا  ـ 
کنید. اجرا  را   Captivate9

ـ نسخه نرم افزار نصب شده روی رایانه 
بخوانید. را  کارگاه 

نوع پروژهکاربرد

Responsive Projectتولید پروژه های پاسخگو

Software Simulation

Video Demo

From PowerPoint

From Adobe Captivate Draftاستفاده از قالب های آماده 

Blank Project

1 برای ایجاد پروژه جدید، نوع پروژه را 
خالی انتخاب کنید.

در پنجره باز شده، روی گزینه New کلیک 
مشاهده  را  پروژه ها  انواع  فهرست  تا  کرده 
کنید. با توجه به نمادها کاربرد هر یک را در 

بنویسید.  1 جدول 

شکل 1ـ انتخاب نوع پروژه جدید

جدول 1ـ انواع پروژه ها

فیلم
 فیلم شماره 10210: نصب نرم افزار کپتیویت

كنجكاوي
کاربرد دکمه Recent چیست؟

 فیلم را مشاهده کرده و فعالیت زیر را انجام دهید.
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2  اندازه صفحه را 768×1024تنظیم کنید.
 ابعاد پروژه شما در این بخش تعیین می شود. با استفاده از 
گزینه Custom می توانید اندازه پهنا و ارتفاع پروژه را به 

دلخواه وارد کنید )شکل 2(.

فعالیت 
كارگاهي

با توجه به شکل 2 کاربرد هر یک از اندازه های صفحهٔ پروژه را بررسی و درباره آنها با هم کلاسی خود 
بحث کنید.

3 پروژه جدید ایجاد کنید.
نرم افزار کپتیویت برای ساخت پروژه از اسلاید )Slide( استفاده می کند. متن، تصویر و رسانه های مورد نیاز 

شما بر روی اسلایدها قرار می گیرند. پروژه جدید به طور پیش فرض یک اسلاید دارد.

4 نوارها و پنل های موجود در صفحه را بررسی کنید.

................

شکل 3ـ محیط نرم افزار 
کپتیویت

شکل 2ـ ابعاد صفحه پروژه

 به کمک هنرآموز خود، عنوان هر یک از بخش های تعیین شده در شکل 3را در کادر مربوطه بنویسید.

فعالیت
گروهی

 پسوند ذخیره سازی پرونده های کپتیویت چیست؟كنجكاوي

................

................................

................

................



122

2  پوسته گرافیکی نشریه را درون اسلاید قرار دهید.
انتخاب کنید. مهم ترین اسلاید پروژه  png پوسته گرافیکی نشریه را  Media> Image خروجی  از مسیر 
تولید محتوای الکترونیک اسلاید اصلی آن است. می توانید از خروجی swf پوسته گرافیکی نیز استفاده کنید. 
این تصویر را می توانید به صورت Background نیز وارد کنید. برای این کار در یک محل خالی روی اسلاید 
کلیک کنید تا انتخاب شود. پنل Properties را باز کنید.که در این صورت برای ایجاد ارتباط بین دکمه های 
 Autoplay media studio پوسته و سایر بخش های پروژه چندرسانه باید از نرم افزارهای مجموعه ساز مثل

استفاده کنید.

در صورتی که نیاز به فارسی نویسی در پروژه دارید، مسیر زیر را اجرا کنید.
Edit > Preferences > General Setting   >   Requires and indi … > Right to Left

5  اسلاید جاری را به عنوان اسلاید ورودی پروژه ویرایش کنید.
مسیر Media> Animation را اجرا کنید. پرونده خروجی iranme که در نرم افزار Swish Max با پسوند 

swf ساخته بودید انتخاب کنید. 
6  اندازه پویانمایی را با اندازه اسلاید تنظیم کنید.

برای تغییر اندازه هر شیء در کپتیویت از مربع های ایجاد شده در اطراف آن استفاده کنید. 
7 پرونده ایجاد شده را با نام » ایران من « ذخیره کنید.

کارگاه 2   ایجاد اسلاید اصلی
1  یک اسلاید خالی به پروژه اضافه کنید.

 از ابزار Slides گزینه Blank Slide را انتخاب کنید. 

برای ایجاد اسلاید خالی می توان از مسیر Insert> New Slide From>Blank Slide نیز استفاده کرد.

جدول 2ـ انواع اسلایدها

به کمک هنرآموز خود کاربرد هر یک از گزینه های شکل را در جدول 2 بنویسید. فعالیت 
كارگاهي

یادداشت

یادداشت
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)Master Slide( کارگاه 3   ایجاد اسلاید الگو

تصویر مورد نظر را به عنوان پس زمینه انتخاب کنید. می توانید به جای تصویر از رنگ برای پس زمینه استفاده 
کنید. 

4  تنظیمات ایجاد نسخه پشتیبان را فعال کنید.
فرض کنید پس از صرف زمان و زحمت زیاد پروژه ای را به آخر رسانده اید و به هر دلیلی پروژه شما برای 
ادامه کار اجرا نمی شود چه می کنید؟ تهیه نسخه پشتیبان، از اقدامات ضروری یک متخصص است. در نسخه 
پشتیبان، یک نسخه مشابه از پروژه نگهداری می شود تا در صورتی که نسخه اصلی پروژه آسیب دید، از آن 

استفاده شود.
گزینه  به   Edit >  Preferences  >  General Setting مسیر  از  پشتیبان  نسخه  ایجاد  تنظیم  برای 
Generate Project Backup  وارد شوید. هربار که پروژه را ذخیره کنید نسخه پشتیبان آن نیز با نام پروژه 

پروژه، ذخیره می شود. کنار  و 
5  پروژه را ذخیره کنید.

برای جلوگیری از تکرار تنظیمات اسلاید می توانید از یک الگو استفاده کنید. در صورتی که روی اسلاید الگو 
تغییراتی انجام دهید، تمام اسلایدهایی که از آن الگو پیروی می کنند تغییر خواهند کرد. 

1  یک پروژه جدید شامل دو اسلاید خالی ایجاد کنید.
2 یک الگو انتخاب کنید.

روی اسلاید اول، از پنل Properties در بخشMaster Slide یک الگو انتخاب کنید.
3  رنگ پس زمینه اسلاید الگو را تغییر دهید.

4 الگو را روی اسلایدها اعمال کنید.
این ترتیب اسلایدهای  انتخاب کنید. به  از بخش Background گزینه Master Slide background را 

انتخابی از اسلاید اول الگو می گیرند.
5 پروژه را با نام »نظرسنجی« ذخیره کنید.

اسلاید های ایجاد شده در بخش نظرسنجی استفاده خواهند شد.

برای استفاده از نسخه پشتیبان کافی است پسوند آن را به cptx تغییر دهید.

برای ایجاد نظم و جلوگیری از پیچیدگی ساخت پروژه، بهتر است برخی بخش ها به صورت جداگانه تولید 
و در انتهای کار، ارتباط بین آنها برقرار شود.

با توجه به معنی Properties کاربرد این پنل چیست؟كنجكاوي

پسوند نسخه پشتیبان پروژه چیست؟كنجكاوي

یادداشت

یادداشت
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شایستگی ها
شرایط عملکرد

)ابزار، مواد، تجهیزات، زمان، مکان و ...(
نمرهاستاندارد )شاخص ها/داوری/ نمره دهی(نتایج ممکن

شایستگی های غیرفنی
کنترل  کیفیت  ـ تفکر خلاق ـ به کارگیري فناوري مناسب ـ 
گردآوری  و  آوری  ـ جمع  گروه  در  نقش  ـ  زمان  مدیریت 

اطلاعات ـ مدیریت کارها و پروژه ها   ـ زبان فنی
قابل قبول

بررسی صحت  پروژه شامل  نهایی  به کیفیت  توجه 
اسلایدها،  محتوای  و  زمینه  صدای  پیوندها، تناسب 
متن های راهنما و پیام های فیلم نمایشی و تعاملی ـ 
انجام وظایف محوله در گروه ـ تقسیم و زمان بندی 
ـ  کارگاه  تجهیزات  از  حفاظت  ـ  گروه  در  وظایف 

فیلم ها و  تصاویر  مالکیت معنوی  رعایت حق 

2

ایمنی و بهداشت
رعایت ارگونومي ـ کنترل حفاظتي الکتریکي و الکترونیکي 

تجهیزات( و  )ابزار 

توجهات
 زیست محیطی

ایجاد محتوای الکترونیک کاهش مصرف کاغذ

1توجه به ایمنی و بهداشت محیط کارگاهغیر قابل قبول

طراحی و ساخت خلاقانه پروژه چندرسانهنگرش

  ارزشیابی مرحله 1

آنچه آموختم:

......................................................................................................................................................................................  1

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

برداشت

مراحل کار
شرایط عملکرد

)ابزار، مواد، تجهیزات، زمان، مکان و ...(
نمرهاستاندارد )شاخص ها/داوری/ نمره دهی(نتایج ممکن

ایجاد پروژه

مکان: کارگاه استاندارد رایانه 
تولید  نرم افزار  که  صدا  کارت  به  مجهز  رایانه   تجهیزات: 
چندرسانه و Flash Player روی آن نصب باشد ـ هدست

زمان: 10 دقیقه

بالاتر
 از حد انتظار

ایجاد یک پروژه خالی ـ تنظیمات نسخه پشتیبان  ـ 
 Master ایجاد  اسلایدـ   تنظیمات  ـ  اسلاید  درج 

Slide  در پروژه
3

در حد انتظار
ایجاد یک پروژه خالی ـ تنظیمات نسخه پشتیبان ـ 

درج اسلایدـ تنظیمات اسلاید
2

پایین تر از 
حد انتظار

1ایجاد یک پروژه خالی ـ تنظیمات نسخه پشتیبان

جدول ارزشیابی شایستگی های غیرفنی، ایمنی و بهداشت و توجهات زیست محیطی
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1 شیء غیرتعاملی متن به اسلاید اضافه کنید.
 در اسلاید دوم پروژه ایران من، بیت »چو ایران نباشد تن من مباد   بدین بوم و بر زنده یک تن مباد« را 
روی کادر زرد رنگ بنویسید. برای درج متن باید ابتدا یک Text Caption به اسلاید اضافه کنید. برای درج 
Text Caption ابزار Text را باز کنید. ابزار متن )Text( سه حالت متن معمولی، جعبه متن ورودی و متن 

متحرک دارد. گزینه Text Caption را انتخاب کنید و بیت بالا را بنویسید.
Text Caption یکی از انواع اشیای غیر تعاملی است. اشیای غیرتعاملی در مقابل رویدادها هیچ واکنشی نشان 
نمی دهند و جهت نمایش از آنها استفاده می شود. ویدئو، تصویر و حرکت ماوس نمونه های دیگری از اشیای 

غیر تعاملی هستند. 
دسته دیگری از اشیا در کپتیویت، اشیای تعاملی هستند که در مقابل رویداد ماوس یا صفحه کلید واکنش نشان 

می دهند. مانند دکمه، جعبه متن های ورودی، ناحیه کلیک کردنی.

کارگاه 4   درج متن

2 متن را انتخاب کنید و در پنل ویژگی ها، تنظیمات آن را انجام دهید )جدول 3(.

با انتخاب هر شیء در سمت راست صفحه، پنل ویژگی های آن شیء ظاهر می شود.

IranNastaliqنوع قلم

اندازه قلم36

# 26760Aرنگ

Align Centerترازبندی

Reflectionدلخواه

کاربرد ابزار Text Entry Box را بررسی کنید.

جدول 3ـ تنظیم ویژگی های متن

فعالیت 
كارگاهي

یادداشت

درج متن
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3 یک متن متحرک درج کنید.
و  کنید  انتخاب  را   Text Animation ابزار 
کلمه IRAN را در آن وارد کنید. ویژگی های 
رنگ  کادر سبز  در  را  آن  و  کرده  وارد  را  متن 

دهید. قرار 
4 در پنل ویژگی ها، جلوه متن را انتخاب 

کنید.
مشاهده  را  جاری  اسلاید  نمایش  پیش   5

کنید.
قبل از خروجی گرفتن از پروژه و در هر یک از 
مراحل کاری پروژه، نیاز هست که پیش نمایش 
ابزار  کار  این  برای  کنیم.  مشاهده  را  آن 
Preview را باز کرده و گزینه Play Slide را 

کنید. انتخاب 

با کمک هم گروهی خود، در جدول 4 کاربرد هر یک از گزینه های ابزار Preview را بنویسید. 

شکل 4ـ تنظیمات متن متحرک

فعالیت 
گروهی

نمایش با استفاده از یک مرورگر

نمایش در فضای ابری

Preview جدول 4ـ گزینه های ابزار
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یکی از ابزارهای پرکاربرد در کپتیویت، اشکال هستند. اشکال در حالت معمولی غیر تعاملی هستند. با تبدیل 
هر یک از اشیا به دکمه می توان آنها را به   صورت تعاملی ایجاد کرد.

1 یک شکل در اسلاید دوم درج کنید.
ابزار Shapes را باز کرده و شکل ستاره را انتخاب کنید و آن را کنار کلمه IRAN متحرک؛ قرار دهید.

2 اندازه ستاره و اندازه زاویه یال های ستاره را تغییر دهید.
برای تغییر اندازه ستاره از مربع های اطراف شکل، استفاده کنید و با مربع زرد رنگ اندازه یال های ستاره را به 

دلخواه تنظیم کنید.
3 در پنل ویژگی ها، تنظیمات را انجام دهید )جدول 5(.

کارگاه 5   درج شکل

کارگاه 6    طراحی اسلاید 

6 پروژه را نمایش دهید.  

4 از شکل، نسخه های مشابه ایجاد کنید.
5 محل اشکال را تعیین کنید.

6 ویژگی های اشکال را تنظیم کنید.

# FFFA00Fill

100Opacity

# FFFA00Stroke

0With

45Angle

Rotate toTimming/Effect

هر یک از اشکال موجود در جعبه ابزار Shapes را با فعال کردن گزینه Use As Button می توان به یک 
شیء تعاملی دکمه تبدیل کرد.

1 اسلاید سوم را ایجاد کنید.
 طبق روندنمایی که در ابتدای کار رسم کردیم، باید منوهای سرو قامتان، محیط زیست ایران من و گالری 

ایران من را در اسلایدهایی جداگانه طراحی کنیم.

جدول 5  ـ تنظیم ویژگی ها

کلید میان بر پیش نمایش کل پروژه را بنویسید.كنجكاوي

یادداشت
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 با استفاده از ابزار Media و Image تصویرP را از پوشه Tolid وارد کنید. تصویر را طوری در اسلاید قرار دهید که کل 
اسلاید را بپوشاند. اگر تصویر از اندازه اسلاید خیلی بزرگ تر بود در پنل ویژگی ها روی گزینه Fit to slide کلیک کنید.

2 یک شکل Rectangular روی اسلاید درج کنید.
رنگ داخل آن را با نمونه رنگ قرمز پرچم پر کنید. Opacity را 80 قرار دهید. عبارت » مدافعان ایران من « را 

داخل شکل بنویسید.
3 از شکل قبل نسخه مشابه ایجاد کنید.

نمونه رنگ سبز پرچم را از روی تصویر برداشته و شکل را با آن رنگ کنید. عبارت »          اردوی جهادی « را داخل شکل 
بنویسید               .

5 یک پویانمایی به اسلاید اضافه کنید.
ابزار Media را باز کرده و گزینه Animation را انتخاب کنید. این ابزار شامل تعداد زیادی از پویانمایی های 

آماده است که براساس شکل دسته بندی شده و در گالری کپتیویت ذخیره شده اند .
پویانمایی Arrow> Left را انتخاب کنید. برای هر دو شکل پویانمایی قرار دهید.

یک  هر  کاربرد  خود  هنرآموز  کمک  به 
را  تصویر  ویرایش  پنجره  گزینه های  از 

. ) 5 شکل ( یسید بنو

4 تصویر را ویرایش کنید.
 در پنجره ویژگی های تصویر روی دکمه Edit Image کلیک کنید. مقدارAlpha را برای  شفافیت تصویر ،40 

و بقیه گزینه ها را صفر قرار دهید.

فعالیت  
كارگاهي

شکل 5  ـ پنل ویرایش تصویر

 Opacity شکل چه مقداری دارد؟ چرا؟كنجكاوي



فصل سوم: تولید چند رسانه ای

129

فعالیت 
كارگاهي

پوسته پروژه کنید.  ایجاد   » Snagit آموزش  الکترونیکی  » درس افزار  نام  به   1024×768 اندازه  با  پروژه ای 
بسازید.  آموختید  قبلًا  که  نرم افزارهایی  با  را  مطالب  فهرست  یا  اصلی  و  ورودی  اسلاید های  گرافیکی 
کنید.  طراحی  و  ایجاد  را  آزمون  و  سرگرمی  عملی،  تمرین  ما،  درباره  راهنما،  آموزش،  اسلایدهای 

کنید. ایجاد  نیز  را  فرعی  اسلایدهای 

)Mouse( و شیء ماوس )Button( کارگاه 7   درج دکمه

1 در اسلاید دوم یک دکمه درج کنید.
ابزار Interaction را باز کرده و گزینه Button را انتخاب کنید. 

دکمه را روی عبارت » سروقامتان« قرار دهید.
2 تنظیمات سبک )Style( دکمه را انجام دهید.

دکمه یکی از اشیای تعاملی پرکاربرد است. دکمه ها را می توان به 
حالت متنی، شفاف و تصویری ایجاد کرد. اغلب برای زیبایی کار در 
صفحه ورودی پروژه، دکمه را به صورت شفاف طراحی می کنند. 

تنظیمات دکمه را انجام دهید )شکل 6(.
3 عملیات دکمه را تنظیم کنید.

در بخش Actions پنل Properties کشوی On Success را باز 
کرده و گزینه Jump to Slide را انتخاب کنید. در کادر پایین آن 

اسلاید شماره 3 را انتخاب کنید.

دکمه ای برای پخش سرود ملی ایران در اسلاید درج کنید و با دکمه دیگری موسیقی را متوقف کنید.

شکل 6  ـ تنظیمات سبک دکمه

فیلم
فیلم شماره 10211 : ایجاد پیوند به دکمه 

فیلم را مشاهده کرده و فعالیت زیر را انجام دهید.
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1 در اسلاید سوم یک شیء Rollover Image درج کنید.
در اسلاید سوم در قسمت بالای صفحه عبارت » برای مشاهده متن و تصویر مدافعان ایران من، روی نام آن 
با ماوس نگه دارید« را وارد کنید. مسیر Object > Rollover Image را اجرا کنید. این ابزار با قرار گرفتن 
ماوس روی یک ناحیه، متن، تصویر، صدا یا فیلمی را درباره آن نمایش می دهد. تصویر شهید فرامرز عباسی 

را از پوشه Tolid انتخاب کنید.
2 ناحیه Rollover را تعیین کنید.

Rollover Area را روی عبارت » مدافعان ایران من « قرار دهید.
3 ناحیه Rollover را طوری تنظیم کنید که در زمان اجرا دیده نشود.

مقدار Width آن را صفر کنید تا Rollover Area زمان اجرا دیده نشود.

در صورتی که دو شیء روی هم قرار گیرند می توان با راست کلیک بر روی یک شیء و انتخاب گزینه 
را روی شیء دیگر نشان داد. Arrange>Bring to Front آن 

4 یک شیء Mouse روی دکمه قرار دهید.
برای این کار وارد مسیر Object > Mouse شوید. انتهای ابزار ماوس را روی کلمه »سروقامتان« قرار دهید. 
از شیء Mouse برای راهنمایی کاربر به کلیک بر روی دکمه استفاده می کنیم. از شیء Mouse، در زمان 

فیلم برداری نیز می توان استفاده کرد. 

6 ابتدای حرکت ماوس را تنظیم کنید.
ابتدای حرکت ماوس را در یکی از گوشه های صفحه قرار دهید.

برای هر یک از بخش های پروژه در اسلاید دوم، مانند »سروقامتان« دکمه شفاف طراحی کنید و براساس 
روندنما آنها را به بخش های مربوطه پیوند دهید. 

فعالیت 
كارگاهي

پروژه

 Rollover Caption  و Rollover Image کارگاه 8   درج اشیای

در پروژه » درس افزار الکترونیکی آموزش Snagit« دکمه های لازم برای اسلایدهای مختلف را بسازید و 
به پرونده های مربوطه پیوند دهید.  

با محتوای دکمه  و  عبارت» محیط زیست «  به  ارتباط  برای  را  اسلاید چهارم  با کمک هم گروهی خود 
» آب«، اسلاید پنجم را برای ارتباط به عبارت » گالری ایران من « و با محتوای دکمه های »نوروز در ایران 

من« و »سوغات ایران من « ایجاد کنید.
برای تمام اسلایدهایی که ایجاد می کنید دکمه بازگشت به صفحه اصلی قرار دهید.

فعالیت 
گروهی

یادداشت
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4  یک شیء Rollover caption درج کنید.
مسیر Object > Rollover Caption را اجرا کنید. متن »شهید فرامرز عباسی اهل مشهد مقدس و عاشق 
امام رضا )ع( بود« را وارد کنید. بخش Rollover Area را روی عبارت »مدافعان ایران من« قرار دهید. مقدار 

Opacity و Width آن را صفر کنید.
5  پروژه را نمایش دهید.

6  به دکمه پیوند ایجاد کنید.
دکمه » اردوی جهادی « را به کلیپ اردوی جهادی که قبلًا تولید کردید پیوند دهید )شکل 7(.

فعالیت 
كارگاهي

کارگاه 9   درج ناحیه بزرگ نمایی

1 اسلاید چهارم را انتخاب کنید.
2 یک ناحیه بزرگ نمایی )Zoom Area ( ایجاد کنید.

برای این کار ابزار Object را باز کرده و گزینه Zoom Area را انتخاب کنید. این ابزار دارای دو بخش است. 
Zoom Source منطقه ای است که بزرگ نمایی روی آن اتفاق می افتد. Zoom Destination محلی است 
که بزرگ نمایی در آن منطقه مشاهده می شود. بخش Zoom Source را روی کلمه » آب « قرار دهید. بخش 
Zoom Destination را روی کلمه» آب « و با اندازه ای بزرگ تر قرار دهید. مقدار بزرگ نمایی به اندازه ای 

که شما تعیین می کنید، بستگی دارد.

نام چند شهید گران قدر استان خود را در زیر کادر مدافعان ایران من وارد کنید و مشخصات و تصویر 
هر یک را نمایش دهید.

شکل 7ـ اسلاید سوم پروژه
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1 یک اسلاید جدید ایجاد کنید.
با  را  شما  ساده  بازی  یک  با  داریم  قصد  اسلاید  این  در 

جاهای دیدنی ایران آشنا کنیم.
2 ابزار Memory Game را باز کنید و تنظیمات آن 

را انجام دهید.
گزینه   Intraction > Learning Intractions مسیر  از 
Memory Game را باز کنید. مطابق شکل 8  ، 10 تصویر از 
پوشه Tolid وارد کنید و نام استان مربوط به آن را در کادر 
مقابل بنویسید. روی دکمه Custom کلیک کنید. شکل 9 
پنجره تنظیمات Memory Game را نمایش می دهد. کلمه 
»IRAN« را در کادر Memory Game تایپ کرده و رنگ آن 
 Play Now را به جای »Please Click«را تغییر دهید. عبارت

تایپ کنید    .
3 زمان برنامه را تنظیم کنید.

زمان برنامه را در قسمت Time، 1 دقیقه و 20 ثانیه تنظیم 
کنید.

4 در کادرهای ابزار، پیغام های مناسب برای موفقیت 
یا عدم موفقیت کاربر بنویسید. 

5 اسلاید جاری را نمایش داده و بازی را انجام دهید. 
6 به دکمه پیوند ایجاد کنید.

اسلاید را به دکمه » دیدنی های ایران من « پیوند دهید.

3 پیش نمایش اسلاید جاری را مشاهده کنید.
کادر محدوده بزرگ نمایی، زمان نمایش دیده می شود.

4 محدوده بزرگ نمایی را طوری تنظیم کنید که در اجرا مشاهده نشود.
 پهنا )Width( را برای هر دو بخش صفر در نظر بگیرید.

5 به دکمه پیوند ایجاد کنید.
 دکمه » آب « را به پرونده گرافیک متحرکی که قبلًا در نرم افزار SwishMax تولید کرده اید، پیوند دهید.

در اسلاید محیط زیست برای هر یک از پروژه های جنگل، حفاظت از خاک و ... از فصل 2 دکمه های 
مناسب طراحی کنید و به آنها پیوند دهید.

فعالیت  
كارگاهي

Memory Game کارگاه 10   درج ابزار تعاملی

شکل 8 ـ تعیین تصویر و نام استان ها

 Memory Game شکل 9ـ تنظیمات
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می خواهیم از جذابیت این ابزار برای ساخت پازل نقشه ایران استفاده کنیم.
1 یک اسلاید جدید ایجاد کرده و ابزار Jigsaw Puzzle را انتخاب کنید.

2 تصویر پازل را انتخاب کنید.
روی دکمه Browse کلیک کنید و تصویر نقشه ایران را از پوشه Tolid  انتخاب کنید.

3     اندازه پازل را 400 ×400 قرار دهید.
4 تعداد قطعات پازل را تعیین کنید.

5 زمان انجام ساخت پازل را تنظیم کنید.
6 در کادرهای ابزار، پیام های مناسب برای موفقیت یا عدم موفقیت کاربر بنویسید. 

7 اسلاید جاری را نمایش داده و بازی را انجام دهید.

)Puzzle( کارگاه 11    درج شیء تعاملی پازل

8 به دکمه پیوند ایجاد کنید.
اسلاید پازل را به دکمه » سرگرمی « در اسلاید دوم پیوند دهید. برای این کار ابتدا یک دکمه شفاف روی نماد 
سرگرمی درج کرده، سپس آن را به اسلاید پازل پیوند دهید. معمولاً دکمه های » سرگرمی«، » نظرسنجی«، 
» درباره ما « و » معرفی سایت های مرتبط« خارج از روندنما طراحی می شوند و می توانند در قسمت بالا یا 

پایین صفحه اصلی قرار  گیرند.

شکل 10ـ تنظیمات پازل

فعالیت 
گروهی

ـ روی تصویر هر یک از نماد ها، دکمه شفاف قرار دهید.
ـ با کمک هم گروهی خود برای هر یک از نماد های درباره ما، معرفی سایت و راهنما، یک اسلاید جدید با 

موضوع مناسب آن طراحی کنید. اسلایدها را به دکمه های شفاف روی نماد ها پیوند دهید.

با توجه به معنی Memory Game کاربرد آن چیست؟كنجكاوي



134

پروژه

 در این بخش می خواهیم کاربر با استفاده از ابزار تعاملی Drag and Drop سوغات هر یک از شهرها را در 
سبدی که نام آن شهر روی آن درج شده قرار دهد.

1 تصاویر مبدأ و مقصد را درج کنید.
در اسلاید هشتم تصویر سبد موجود در پوشه Tolid را وارد صفحه کنید. از تصویر سبد نسخه مشابه ایجاد 
کنید   . هر دو تصویر را سمت راست صفحه قرار دهید. روی سبد اول کلمه » مشهد« و روی سبد دوم کلمه 
» زنجان « را بنویسید  . از پوشه Tolid تمام تصاویر سوغات را وارد صفحه کنید. اندازه تصاویر را کوچک کنید 

و چیدمان مناسبی برای آنها در نظر بگیرید  .
2 ابزار Interaction  را باز کرده و گزینه Drag and Drop را انتخاب کنید. 

در پنجره باز شده 3 گام وجود دارد.
 تصاویر مربوط به سوغات مشهد را با پایین نگه داشتن کلید Ctrl انتخاب کنید.

در کادر بالای صفحه روی علامت + کلیک کنید و نام مشهد را تایپ کنید.
در یک جای خالی کلیک کنید و همین کار را برای تصاویر سوغات شهر زنجان انجام دهید.

 با کلیک روی دکمه Next و پایین نگه داشتن کلید Ctrl تصاویر سبد را انتخاب کنید. سبدها منبع دریافت 
سوغات تعریف می شوند.

 تمام تصاویر مربوط به سوغات شهر مشهد را انتخاب کنید. در وسط یکی از تصاویر دایره ای وجود دارد آن را 
به سمت سبد مشهد درگ کنید تا تمام تصاویر مربوط با فلش به سمت سبد مشهد مشخص شوند )شکل 11(    .

3 برای گزینه های دیگر نیز عملیات را تکرار کنید.
این مراحل را برای تصاویر مربوط به سوغات شهر زنجان نیز انجام داده و روی دکمه Finish کلیک کنید.

بازی  با ساخت  را  برای دکمه سرگرمی،  آموزشی   » Snagit الکترونیکی آموزش  پروژه » درس افزار  در 
خلاقانه ایجاد کنید. سعی کنید از دیگر امکانات پنجره Learning Intractions استفاده کنید. برای 

قرار دهید.  اسلاید     سرگرمی  یک موسیقی مناسب 

Drag and Drop کارگاه 12   حرکت اشیا با ابزار

شکل 11ـ برچسب زدن گزینه ها
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5 تناظر یک به یک بین مبدأ و مقصد ایجاد کنید.
 Accepted Drag کلیک کنید. در پنجره Object Action در پنجره خصوصیات سبد مشهد روی دکمه

Source تنها گزینه مشهد را انتخاب کنید و بقیه را از حالت انتخاب خارج کنید.
6 مراحل برای سبد زنجان نیز انجام دهید.

4 موقعیت قرار گرفتن اشیا را تنظیم کنید.
 در پنجره ویژگی های سبد مشهد مانند شکل Position 12 آن را تنظیم کنید. مقدار Opacity را صفر 

دهید. قرار 

تنظیم پنجره Accepted Drag Source از جابه جایی گزینه ها در سبد دیگر جلوگیری می کند  . 

7  اسلاید را نمایش دهید.
8  به دکمه پیوند ایجاد کنید.

ارتباط این اسلاید را با دکمه » سوغات ایران من « در اسلاید گالری برقرار کنید.

فعالیت 
سوغات استان و شهر خود را به مجموعه سوغات اسلاید قبل اضافه کنید.كارگاهي

شکل 12ـ تعیین محل تصاویر اشیا

در شکل 12 تنظیم Snap Behavior چه عملی انجام می دهد؟كنجكاوي

یادداشت
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در این بخش از پروژه می خواهیم از یک پرونده فیلم برداری کرده و در حین فیلم برداری توضیحاتی در مورد 
موضوع آن بدهیم. فیلم برداری در حالت نمایشی )Demo(، غیر تعاملی بوده و کاربر تنها می تواند فیلم را 

مشاهده کند. قبل از انجام مراحل کارگاه، سناریوی فیلم برداری از صفحه نمایش را بنویسید.
 یک پروژه از نوع فیلم برداری غیرتعاملی ایجاد کنید. 1

از منوی File> Record a New > Video Demo را انتخاب کنید.
 برنامۀ مورد نظر برای فیلم برداری را اجرا کنید. 2

پاورپوینت Noroz را از پوشه Tolid انتخاب و آن را در حالت نمایشی اجرا کنید.
3 تنظیمات فیلم برداری را انجام دهید.

 محدوده فیلم برداری را تمام صفحه )Full Screen( تنظیم کنید.

مراحل کار
شرایط عملکرد

 )ابزار  ،   مواد   ، تجهیزات  ، زمان  ، مکان و ...(
نمرهاستاندارد )شاخص ها/  داوری/  نمره دهی(نتایج ممکن

درج اشیا 

مکان : کارگاه استاندارد رایانه 
تجهیزات : رایانه  مجهز به کارت صدا که نرم افزار 
آن  روی   Flash Player و  چندرسانه  تولید 

نصب باشد ـ هدست
زمان :20 دقیقه

بالاتر
 از حد انتظار

افزودن اشیای تعاملی و غیرتعاملی به پروژه ـ ایجاد پیش نمایش ـ 
3تنظیمات اشیای تعاملی  ـ  تنظیمات اشیای غیرتعاملی

افزودن اشیای تعاملی و غیرتعاملی به پروژه ـ ایجاد پیش نمایش  ـ در حد انتظار
2تنظیمات اشیای غیرتعاملی

پایین تر از
 حد انتظار

1افزودن اشیای غیرتعاملی به پروژه ـ ایجاد پیش نمایش

 ارزشیابی مرحله 2

کارگاه 13   فیلم برداری نمایشی

آنچه آموختم:

......................................................................................................................................................................................  1

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

برداشت
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4 میکروفن را نصب کنید.
5 فیلم برداری را شروع کنید.

  فیلم برداری را خاتمه دهید. 6 با انتخاب دکمه 
فیلم ضبط شده نمایش داده می شود.

7 فیلم را ویرایش کنید.
در صورتی که از صحت فیلم برداری اطمینان دارید روی دکمه Edit کلیک کنید. فیلم وارد محیط کپتیویت 
می شود. در شکل 14 ناحیه خط زمان )TimeLine( را مشاهده می کنید. در صورت عدم مشاهده خط زمان 
از منوی Window گزینه TimeLine را فعال کنید. در این ناحیه تمام اشیای موجود در اسلاید، مدت زمان 
نمایش هر یک از اشیا و ترتیب آنها قابل کنترل است. اگر زمان نمایش یک اسلاید را تغییر دادید، برای نمایش 
سایر اشیا تا انتهای اسلاید، روی شیء مورد نظر راست کلیک کرده و گزینه Show For Rest Of Slide را 

انتخاب کنید. در غیر این صورت نمایش اشیا به پایان می رسد اما صدا همچنان پخش می شود.

شکل13ـ تنظیمات فیلم برداری

 شکل 13 تنظیمات فیلم برداری 
جاهای  در  می دهد.  نشان  را 
خالی کاربرد هر یک از گزینه ها 

را بنویسید.

فعالیت 
كارگاهي

کدام کلید تابعي برای پایان فیلم برداري استفاده می شود؟كنجكاوي

انتخاب
میکروفن

................

................

................

جابه جایی
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8 عبارت » تهیه کننده : نام و نام خانوادگی خودتان « را در انتهای فیلم درج کنید.
9 فیلم را با ابزار Split به دو بخش تقسیم کنید و بین دو تکه فیلم جلوه گذار تعیین کنید.

در محل تقسیم فیلم از پنجره ویژگی های آن Transition>Left را انتخاب کنید. 

با کشیدن خط زمان هر شیء می توانید مدت زمان نمایش آن را تنظیم کنید.

با گزینه Trim می توانید بخشی از فیلم خود را برش بزنید. 

شکل 14ـ ناحیه خط زمان

از آموزش خود در محیط Snagit فیلم برداری نمایشی انجام دهید و آن را ذخیره کنید  . این پرونده بعد پروژه
از گرفتن خروجی در پروژه اصلی قرار می گیرد  .

10  فیلم را نمایش دهید و پروژه فیلم برداری را با نام »نوروز« در محیط کپتیویت ذخیره کنید.
این پرونده به صورت مستقل و جدا از پروژه اصلی ذخیره می شود تا در انتهای کار خروجی آن را در پروژه 

به کار  گیریم. اصلی 

علامت   و       چه کاربردی دارند؟كنجكاوي
در زمان ویرایش فیلم چه اشیای تعاملی یا غیرتعاملی از ابزارها فعال هستند؟

یادداشت

یادداشت

مدت زمان نمایش شیء

نوار لغزنده بزرگ نمایی
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پس از نوشتن سناریو می توانید فیلم برداری را انجام دهید.
1 یک پروژه جدید برای فیلم برداری تعاملی ایجاد کنید.

از مسیر File > Record a New > Software Simulation وارد پنجره تنظیمات فیلم برداری شوید.
2 روش فیلم برداری Training را انتخاب کنید.

گزینه Demo را از حالت انتخاب خارج کنید.
3 تنظیمات لازم را مشابه روش Demo انجام دهید.

4 به وسیلۀ دکمۀ Record و مطابق سناریو فیلم برداری کنید.
5 فیلم برداری را خاتمه دهید.

کارگاه 14    فیلم برداری به روش تعاملی

دو روش فیلم برداری تعاملی وجود دارد. در روش Training کاربر در زمان پخش فیلم، می تواند در محل هایی 
که رویداد ماوس یا صفحه کلید انجام شده راهنمایی دریافت کرده و با انجام آن ادامه فیلم را مشاهده کند. 
این روش برای آموزش و تمرین بسیار مناسب است. روش Assessment مشابه روش Training است با این 

تفاوت که هنگام پخش فیلم، کاربر هیچ راهنمایی دریافت نمی کند.
سناریوی فیلم برداری : می خواهیم با جستجو در اینترنت موضوع »مشاهیر ایران« را فیلم برداری کنیم.

    شماره مراحل
    عنوان : مشاهیر ایران

انیمیشن فیلم تصویر  صدا نام محتوا: نشریه الکترونیکی ایران من   متن    

1

)Narration( گفتار

کار  تعاملی  فیلم برداری  ابزار  از  استفاده  با  کنید.  باز  را  خود  مرورگر  شوید.  متصل  اینترنت  به 
از  یکی  روی  کنید.  وارد  را  ایران«  عبارت »مشاهیر  مرورگر خود  در  کنید.  را شروع  فیلم برداری 
لینک های مورد نظر کلیک کنید. سایت های مورد نظر را بیابید. متن ها و تصاویر را در سیستم 

کنید. ذخیره  را  پروژه  دهید.  خاتمه  را  فیلم برداری  کنید.  ذخیره 
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6 عبارت های داخل کادرهای قرمز را دابل کلیک کرده و ترجمه آنها را به منظور ساخت راهنما 
بنویسید )شکل 15(.

7 پروژه را نمایش دهید و با نام »مشاهیر ایران« ذخیره کنید.
این پرونده نیز مانند پرونده » نوروز« به صورت مستقل ذخیره می شود تا در انتهای کار به پروژه اصلی پیوند 

داده شود.

كنجكاوي

فعالیت 
فیلم برداری را با روش Assessment انجام دهید.كارگاهي

سه روش فیلم برداری Demo  و Training و Assessment را با هم مقایسه کنید.

در روش ترکیبی می توانید از هر سه حالت فیلم برداری استفاده کنید. در روش ترکیبی ابتدا فیلم برداری به 
صورت نمایشی )Demo( ضبط می شود، سپس با انتخاب دیگر حالت های فیلم برداری، فیلم به صورت تعاملی 

ضبط خواهد شد.

شکل 15ـ ترجمه عبارت های راهنما

فیلم شماره 10212: فیلم برداری ترکیبیفیلم

فیلم را مشاهده کرده و فعالیت صفحه بعد را انجام دهید.
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پروژه

فعالیت 
پروژه » مشاهیر ایران« را به صورت ترکیبی، فیلم برداری کنید.كارگاهي

از  تعاملی  فیلم برداری  جدید،  پرونده  یک  در   ،» Snagit آموزش  الکترونیکی  »  درس افزار  پروژه  برای 
تعاملی« ذخیره کنید. نام »فیلم برداری  با  را  آن  تهیه کنید  آموزش خود 

مراحل کار
 شرایط عملکرد

)ابزار، مواد، تجهیزات، زمان، مکان و ...(
نتایج 
ممکن

نمرهاستاندارد )شاخص ها/داوری/نمره دهی(

فیلم برداری
 از صفحه نمایش

مکان: کارگاه استاندارد رایانه 
که   صدا  کارت  به  مجهز  رایانه   تجهیزات: 
 Flash Player و  چندرسانه  تولید  نرم افزار 

هدست  – باشد  نصب  آن  روی  
زمان:20 دقیقه

بالاتر
 از حد انتظار

و  نمایشی  روش  به  نمایش  از صفحه  فیلم برداری 
ویرایش آن– فیلم برداری از صفحه نمایش به روش 

تعاملی و ویرایش آن– ضبط پروژه های ترکیبی
3

در حد انتظار
نمایشی  روش  به  نمایش  صفحه  از  فیلم برداری 
به  نمایش  از صفحه  –  فیلم برداری  آن  ویرایش  و 

آن ویرایش  و  تعاملی  روش 
2

پایین تر از 
حد انتظار

نمایشی   ـ  روش  به  نمایش  صفحه  از  فیلم برداری 
تعاملی  روش  به  نمایش  صفحه  از  1فیلم برداری 

 معیار شایستگی انجام کار:
  کسب حداقل نمره 2 از مراحل درج اشیا و فیلم برداری از صفحه نمایش

  کسب حداقل نمره 2 از بخش شایستگی های غیر فنی، ایمنی، بهداشت، توجهات زیست محیطی و نگرش 
کسب حداقل میانگین 2 از مراحل کار

ارزشیابی مرحله 3

آنچه آموختم:

......................................................................................................................................................................................  1

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

برداشت
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شرح کار:
3  فیلم برداری از صفحه نمایش  2  درج اشیا                      1  ایجاد پروژه                 

استاندارد عملکرد: 
با استفاده از نرم افزار تولید محتوا، از صفحه نمایش فیلم برداری کرده و با استفاده از امکانات نرم افزار و رسانه های مختلف، محتوای الکترونیک تولید کند.

شاخص ها:

شاخص های مرحله کارشماره مرحله کار

1
ایجاد  اسلاید  -  مشخصات  تنظیم  درج   –  برای  اسلاید  نوع  انتخاب   - پروژه  پشتیبان  نسخه  ایجاد  تنظیمات  پروژه   -  نوع  انتخاب 

Master Slide الگوی  با  اسلاید  درج   –  Master Slide

2
انتخاب شیء تعاملی- تنظیم مشخصات تعیین شده شیء تعاملی- انتخاب شیء غیرتعاملی- تنظیم مشخصات تعیین شده شیء 

انتخاب نوع پیش نمایش- مشاهده پیش نمایش غیرتعاملی- 

3
فیلم  ویرایش  فیلم برداری-  روش  تنظیمات  انجام  نمایش-  صفحه  از  فیلم برداری  روش  انتخاب  فیلم برداری-  محدوده  انتخاب 
نمایشی- ویرایش فیلم تعاملی- ضبط هم زمان فیلم به چند روش –  انتخاب اسلایدهای یک پروژه فیلم برداری و ترکیب آنها با 

دیگر فیلم برداری  پروژه 

شرایط انجام کار و ابزار و تجهیزات: 
مکان : کارگاه رایانه مطابق استاندارد تجهیزات هنرستان ها

تجهیزات : رایانه  مجهز به کارت صدا که نرم افزار تولید چندرسانه و Flash Player روی آن نصب باشد- هدست
زمان : 50 دقیقه )ایجاد پروژه 10 دقیقه - درج اشیا 20 دقیقه – فیلم برداری از صفحه نمایش20 دقیقه(

معیار شایستگی: 

نمره هنرجوحداقل نمره قبولی از 3 مرحله کارردیف

1ایجاد پروژه1

2درج اشیا2

2فیلم برداری از صفحه نمایش3

شایستگی های غیرفنی، ایمنی، بهداشت، توجهات زیست محیطی و نگرش:
کنترل کیفیت ـ تفکر خلاق ـ به کارگیري فناوري مناسب ـ مدیریت زمان ـ نقش در گروه ـ جمع آوری 
و گردآوری اطلاعات ـ مدیریت کارها و پروژه ها ـ زبان فنی ـ رعایــت ارگونومــي ـ کنتــرل حفاظتــي 
الکتریکــي و الکترونیکــي )ابــزار و تجهیــزات(ـ ایجاد محتوای الکترونیک ـ کاهش مصرف کاغذ ـ طراحی و 

پروژه چندرسانه ساخت خلاقانه 

2

*میانگین نمرات

* حداقل میانگین نمرات هنرجو برای قبولی و کسب شایستگی، 2 است.

جدول ارزشیابی پایانی
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  چگونه می توان یک آزمون الکترونیکی ایجاد کرد؟
 چگونه می توان آزمون با سؤالات تصادفی ایجاد کرد؟

  چگونه می توان مانع نمایش اطلاعات کارنامه آزمون شد؟
 چگونه می توان یک بسته محتوای الکترونیک را آماده و تولید کرد و نشر داد؟

  چه نوع خروجی هایی می توان از یک پروژه چندرسانه تولید کرد؟

هدف از این واحد شایستگی ساخت آزمون الکترونیکی همراه با کارنامه و مجموعه سازی است.

آیا تا به حال پی برده اید

استاندارد  عملکرد

 با استفاده از نرم افزار تولید محتوا آزمون الکترونیکی با تنوع سؤال تولید کند. آزمون هایی با سؤالات تصادفی 
بسازد. مجموعه سازی  کرده و پروژه تولید کند.

واحد یادگیری 6 

   شایستگی آزمون سازی و تولید چندرسانه ای 
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1 یک پروژه جدید با اندازه 768×1024 ایجاد کنید. 
2 تنظیمات آزمون را انجام دهید. 

3 نمره قبولی آزمون را با 50 درصد پاسخ صحیح تنظیم کنید.
4 تعیین کنید بعد از قبولی در آزمون، کاربر یک تصویر مناسب دریافت کند.

5 آزمون را طوری تنظیم کنید که کاربر در صورت عدم موفقیت در آزمون بتواند مجدد در آزمون 
شرکت کند.

6 آزمون را طوری تنظیم کنید که در صورت عدم موفقیت، کاربر به اسلایدی برای مطالعه راهنمایی 
شود.

کارگاه 1    تنظیمات ساخت آزمون

آزمون های الکترونیکی 
 آزمون، وسیله یا روشی نظام مند است که برای اندازه گیری نمونه ای از رفتار مورد استفاده قرار می گیرد. در 
نظام آموزشی، آزمون وسیله یا روشی برای اندازه گیری میزان یادگیری است. به آزمون هایی که با استفاده 
از سیستم الکترونیکی انجام می شوند، آزمون الکترونیکی می گویند. با پایان یافتن آزمون الکترونیکی، نمره 

آزمون و پاسخ های صحیح به صورت الکترونیکی نمایش داده شده و کارنامه آن صادر می شود.

فعالیت 
در شکل 16، اجرای آزمون ها را با هم مقایسه کرده و در مورد مزایا و معایب آنها با هم کلاسی های خود گروهی

گفتگو کنید. 

پژوهش
در مورد آزمون های برخط و تفاوت آن با آزمون های الکترونیکی تحقیق کنید. 

شکل 16ـ انواع آزمون

 فیلم شماره 10213 : تنظیمات آزمون فیلم

 فیلم را مشاهده کرده و عملیات زیر را انجام دهید.
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فعالیت 
كارگاهي

7 در اولین اسلاید، عنوان آزمون و توضیحات مربوط به آزمون را بنویسید.

Reporting

Setting

Pass or Fail

Default Labels

در پنجره تنظیمات آزمون در شکل 17، هر یک از دکمه ها و پیام های آزمون را ترجمه کنید تا در حین 
ساخت آزمون از تکرار ترجمه آن در هر سؤال جلوگیری شود.

شکل 17ـ تنظیمات آزمون

هر یک از بخش های جدول 6 چه تنظیماتی در كنجكاوي
انجام می دهند؟  آزمون 

جدول 6  ـ تنظیمات آزمون

آنچه آموختم:

......................................................................................................................................................................................  1

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

برداشت
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ارزشیابی مرحله 1

1 یک اسلاید سؤال چند گزینه ای اضافه کنید.
 از منوی Quiz گزینه Question Slide را انتخاب کنید. از چه راه دیگری می توانید اسلاید سؤال اضافه 

کنید؟

)Multiple Choice(کارگاه 2   درج سؤال چندگزینه ای

برای مشاهده پنجره سؤالات می توان از کلیدهای ترکیبی Shift+Ctrl+Q نیز استفاده کرد.

شایستگی ها
 شرایط عملکرد

)ابزار، مواد، تجهیزات، زمان، مکان و ...(
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

شایستگی های 
غیرفنی

فناوري  به کارگیري  خلاق –  تفکر  ـ  کیفیت  کنترل 
جمع آوری  ـ  گروه  در  نقش  ـ  زمان  مدیریت  مناسب 
و گردآوری اطلاعات ـ مدیریت کارها و پروژه ها ـ زبان 

قابل قبولفنی

چندرسانه  پروژه  نهایی  کیفیت  به  توجه 
با  آزمون  پیام های  تناسب  بررسی  شامل 
نتیجه، صحت پیوند پیش آزمون با اسلاید 
مربوطه با توجه به نتیجه ـ انجام وظایف 
زمان بندی  و  تقسیم  ـ  گروه  در  محوله 
تجهیزات  از  حفاظت  ـ  گروه  در  وظایف 

کارگاه

2

ایمنی و بهداشت
رعایت ارگونومي ـ کنترل حفاظتي الکتریکي و الکترونیکي 

)ابزار    و   تجهیزات(

توجهات
 زیست محیطی

ایجاد محتوای الکترونیک کاهش مصرف کاغذ
1توجه به ایمنی و بهداشت محیط کارگاهغیر قابل قبول

دقت در محافظت از سؤالات آزموننگرش

با توجه به نماد های شکل 18، نوع هر یک از سؤالات را حدس بزنید و در مقابل آن بنویسید. كنجكاوي

یادداشت

مراحل کار
 شرایط عملکرد

)ابزار، مواد، تجهیزات، زمان، مکان و ...(
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

تنظیمات آزمون

مکان: کارگاه استاندارد رایانه 
تجهیزات: رایانه ای که نرم افزار تولید چندرسانه و

 Flash  Player روی آن نصب باشد  .
زمان:10 دقیقه

بالاتر
 از حد انتظار

انجام تنظیمات قبل و بعد از آزمون ـ فارسی 
کردن پیام های آزمون

3

2انجام تنظیمات قبل و بعد از آزموندر حد انتظار

پایین تر از
 حد انتظار

1انجام تنظیمات قبل از آزمون 

جدول ارزشیابی شایستگی های غیرفنی، ایمنی و بهداشت و توجهات زیست محیطی
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گزینه  است.  چندگزینه ای  سؤالات  الکترونیکی،  آزمون های  در  سؤالات  انواع  کاربردی ترین  از  یکی 
می شود.  فعال  گزینه  دو  با  سؤال  یک  آن  انتخاب  با  کنید.  انتخاب  را   Multiple   choice

2 تعداد سؤالات چندگزینه ای را وارد کنید.
3 برای محاسبه نمره، گزینه Graded را انتخاب کنید. 

 متن سؤال، گزینه هاي پاسخ و پیام هاي مرتبط با سؤال و دکمه ها را بنویسید )شکل 19(. 4

شکل 18ـ کادر تعیین نوع سؤال

پژوهش
در مورد طراحی سؤالات تشریحی در کپتیویت اطلاعاتی را جمع آوری کرده و به کلاس ارائه دهید.

تعداد سؤال امتیاز آزمون

كنجكاوي
گزینه Survey چه کاربردی دارد؟

کلیک کردنی

نظرسنجی
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5 محل پیام های آزمون را تنظیم کنید.
از آزمون تنظیم کرده اید  بازبینی )Review Area(، هنگام مرور پاسخ ها، پیام هایی را که پیش  در ناحیه 

مشاهده می کنید. با کشیدن هر یک، آنها را در جای مناسبی از اسلاید جهت نمایش قرار   دهید  . 

با ایجاد اولین سؤال نمره دار )Graded( ، اسلاید کارنامه )Quiz Result(، به طور خودکار ایجاد می شود.

6 پاسخ صحیح هر سؤال را در متن سؤال علامت بزنید.

پاسخ سؤال در هنگام اجرای آزمون برای کاربر قابل مشاهده نخواهد بود و تنها برای تصحیح سؤال و 
صدور کارنامه استفاده می شود.

شکل 19ـ  ساخت سؤال چندگزینه ای

یادداشت

یادداشت
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7 تنظیمات سؤال را انجام دهید.
 برای این مرحله فیلم را مشاهده کنید.

فعالیت 
با کمک هنرآموز خود در شکل 20 کاربرد هر یک كارگاهي

از گزینه ها را بنویسید و تنظیمات سؤال را به صورت 
زیر انجام دهید:

سؤال  که  کنید  تنظیم  طوری  را  گزینه ها  تعداد  ـ 
باشد. گزینه   4 دارای 

صورت  به  که  کنید  تنظیم  طوری  را  گزینه ها  ـ 
شوند. جابه جا  تصادفی 

ـ برای سؤال خود 3 نمره منفی تعریف کنید. 
ـ شماره گذاری گزینه ها را تغییر دهید. 

ـ سؤال را طوری تنظیم کنید که در صورت پاسخ 
صحیح و یا بدون پاسخ پیام مناسب دهد.

ـ برای سؤال خود محدوده زمانی تعریف کنید.
ـ دکمه های پاک کردن، بازگشت، انصراف و سعی 

مجدد را برای سؤال فعال کنید.

شکل 20ـ تنظیمات سؤال

فیلم
 فیلم شماره 10214 : تنظیمات سؤال
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فعالیت 
كارگاهي

1 یک سؤال از نوع Fill in the Blank اضافه کنید.
 این نوع از سؤالات کوته پاسخ برای کامل کردن یک عبارت به کار می روند. 

2 متن سؤال را به گونه ای وارد کنید که کلمه پاسخ در محل Blank قرار گیرد.
در صورتی که متن سؤال دارای بیش از یک جای خالی است کلمات یا عبارت های مورد نظر را انتخاب و در 
پنل Quiz با انتخاب گزینه Mark Blank آن را علامت دار کنید تا کپتیویت، آن را به عنوان عبارت جای خالی 

بشناسد.

8 با استفاده از کلیدF4 یا F8 سؤال را نمایش دهید.

یک سؤال از نوع درست )True(/ نادرست  )False( ایجاد کنید. این نوع سؤالات درستی یا نادرستی یک 
عبارت را تعیین می کنند و دارای دو گزینه هستند. تنظیمات سؤال را انجام داده و سؤال را نمایش دهید.

کارگاه 3   درج سؤالات کوته پاسخ

دو گزینه List User Input و DropDown در پایین پنجره تنظیمات باعث ایجاد پاسخ های بسته و 
باز می شود.

شکل 21 ـ سؤال درست / نادرست

سؤال را طوری تنظیم کنید که پس از پاسخ، به اسلاید سؤال بعدی برود  .كنجكاوي

یادداشت
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3 تنظیمات سؤال را انجام داده و سؤال را نمایش دهید.
4 یک سؤال از نوع کوته پاسخ )Short Answer( ایجاد کنید.

این نوع سؤالات دارای یک پاسخ کوتاه هستند که کاربر می تواند پاسخ خود را در کادر آن بنویسد.
5 متن سؤال را وارد کنید.

6 پاسخ سؤال را وارد کنید.
روی متن یا عبارت مورد سؤال دابل کلیک کنید )شکل 22(.

)Matching( کارگاه 4   درج سؤال جورکردنی

7  سؤال را طوری تنظیم کنید که پاسخ نسبت به حروف کوچک و بزرگ حساس نباشد.
8 سؤال را نمایش دهید.

1 یک سؤال از نوع جور کردنی ایجاد کنید.
در این نوع سؤالات کاربر باید گزینه های مرتبط را 
با کشیدن گزینه ها یا انتخاب از فهرست کشویی به 

یکدیگر وصل کند.
2 سؤال را وارد کنید.

3 تعداد گزینه های ستون ها را افزایش دهید.
4  تنظیمات سؤال را انجام دهید.

5 پاسخ سؤال را با استفاده از کشوهای مربوطه 
مشخص کنید.

6 سؤال را نمایش دهید.

شکل 22ـ سؤال کوته پاسخ

شکل 23ـ سؤال جور کردنی

در شکل 22 کاربرد علامت + و - را بنویسید.كنجكاوي

.......................

.......................
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)Hot Spot(کارگاه 5    درج سؤال کلیک کردنی

)Sequence( کارگاه 6    درج سؤال ترتیبی

در این نوع سؤالات از کاربر خواسته می شود تا در محل یا محل های موردنظر روی تصویر کلیک کرده و به 
سؤال پاسخ دهد.

1 یک سؤال از نوع کلیک کردنی ایجاد کنید.
2  متن سؤال را بنویسید )شکل 24(. 

از مسیر Media>Image تصویر نقشه ایران را از پرونده Map وارد کنید.
3 سؤال را طوری تنظیم کنید که دارای بیش از یک پاسخ باشد.

4 نقاط پاسخ را روی نقشه مشخص کنید.
5 تنظیمات سؤال را انجام داده و سؤال را نمایش دهید.

در این نوع سؤالات کاربر با مرتب کردن گزینه ها، ترتیب آنها را نشان می دهد. 
1 یک سؤال از نوع ترتیبی ایجاد کنید.

2 تعداد گزینه های سؤال را به 10 گزینه افزایش دهید.
3 متن سؤال را وارد کنید.

شعر سرود ملی ایران را در هر یک از گزینه ها به صورت مرتب وارد کنید.
4 روش پاسخ گویی را تعیین کنید.

به روش  بار  و یک   Drag Drop را  به سؤال  پاسخ گویی  Answer Type ، روش  Quiz گزینه  پنل  از 
دهید. تغییر   List DropDown

شکل 24ـ سؤال کلیک کردنی

چگونه می توان خط دور پاسخ ها را حذف کرد به  طوری که زمان اجرا قابل مشاهده نباشد؟كنجكاوي
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5 سؤال را نمایش داده و کارنامه 
آزمون را مشاهده کنید.

با ایجاد اولین سؤال در آزمون، کارنامه در آخرین اسلاید نمایش داده می شود. با توجه به اینکه متغیرهای 
نتیجۀ آزمون درون } { هستند، از تغییر آنها خودداری کنید.

فعالیت 
به اسلاید کارنامه بروید. کاربرد هر یک از سطرهای کارنامه را بنویسید )شکل 26(.كارگاهي

شکل 25ـ سؤال مرتب کردنی

شکل 26ـ کارنامه آزمون

چگونه می توان با استفاده از تنظیمات کارنامه در پنل Quiz متغیرهای کارنامه را مخفی کرد؟ كنجكاوي

دقت

تعداد دفعات
تکرار آزمون
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برای  نظرسنجی  سؤالات  چطور؟  الکترونیکی  نظرسنجی  کرده اید؟  شرکت  نظرسنجی  یک  در  تا کنون  آیا 
سنجش یک موضوع به کار می روند.

1 پرونده »نظر سنجی« را باز کنید.
2 انتهای پروژه یک سؤال از نوع نظرسنجی ایجاد کنید.

3 سؤال را وارد کنید.
4 کاربرد گزینه های سؤال را بررسی کنید.

6 با فشردن کلید F4 آزمون را اجرا کنید.

)Scale Rating( کارگاه 7    درج سؤال نظر سنجی

کاربرد هر یک از گزینه های شکل 27 را بنویسید. فعالیت 
كارگاهي

در  دیگر  نظرسنجی  سؤال  سه   5
کنید. اضافه  نشریه  مورد 

 با فشردن کلید F4 به سؤال مورد  6
نظر پاسخ دهید.

 پروژه را ذخیره کنید. 7

شکل 27ـ گزینه های سؤال نظرسنجی

شکل 28ـ سؤال نظرسنجی

چرا گزینه Graded برای سؤالات نظرسنجی غیرفعال است؟كنجكاوي

)3()2()1( )4( )5(
...................................................................................................................
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فعالیت 
كارگاهي

پژوهش

پژوهش

به کمک هنرآموز خود یک نظرسنجی را تحلیل و بررسی کنید.

پیش آزمون: به آزمونی که پیش از آموزش انجام می گیرد، پیش آزمون می گویند. پس از برگزاری پیش آزمون 
عمل آموزش انجام می شود و در پایان آموزش، آزمون نهایی انجام می شود. از آنجا که معمولاً پیش آزمون و 
آزمون مشابه است، فراگیران با گذراندن پیش آزمون تعیین سطح شده، در کلاس یا دوره آموزشی شرکت 

کرده و در پایان آموزش، در آزمون نهایی شرکت می کنند. پیش آزمون چه مزیتی دارد؟ 

پیش آزمونی با حداکثر 3 سؤال از اطلاعات عمومی درباره ایران ایجاد کنید. در صورت موفقیت کاربر در 
آزمون، سؤالاتی که در کارگاه های قبل ساختید به عنوان آزمون ارائه داده و در غیر این صورت اسلایدی با 

عنوان » نیاز به مطالعه بیشتر« نمایش دهید.

در مورد تفاوت Prteset Question slide و Knowlage Check slide تحقیق کنید و نتیجه را به 
کلاس ارائه دهید.

مراحل کار
 شرایط عملکرد

)ابزار،  مواد، تجهیزات، زمان، مکان و ...(
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

ساخت آزمون 
الکترونیکی

مکان: کارگاه استاندارد رایانه 
تجهیزات: رایانه ای که نرم افزار تولید چندرسانه

و Flash Player روی آن نصب باشد  .
زمان: 20 دقیقه

بالاتر از حد انتظار
درج انواع سؤال ـ تنظیمات سؤال ـ صدور و تنظیمات 

کارنامه – ایجاد پیش آزمون
3

2درج انواع سؤال ـ تنظیمات سؤال در حد انتظار

پایین تر از حد 
انتظار

1درج انواع سؤال

 ارزشیابی مرحله 2

فیلم
 فیلم شماره 10215 : ایجاد پیش آزمون

 فیلم را مشاهده کرده و فعالیت زیر را انجام دهید.
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کارگاه 8    ساخت آزمون با سؤالات تصادفی

1 بانک سؤال ایجاد کنید.
برای ساخت آزمون با سؤالات تصادفی ابتدا بانک سؤال ایجاد می کنیم تا بتوان سؤالات را به صورت تصادفی از 

بانک سؤال انتخاب کرد. از مسیر Quiz>Question Pool Manager وارد کادر مدیریت بانک سؤال شوید.
2 طبقه بندی سؤالات را تعیین کنید.

برای ایجاد بانک سؤال با کلیک روی علامت + در سمت چپ، منابع یا طبقه بندی سؤالات آزمون را تعیین 
و نام گذاری کنید )شکل 29(.

3 تعداد سؤالات هر طبقه بندی را تعیین کنید.
روی هر یک از منابع آزمون کلیک کنید و با انتخاب علامت + از کادر مقابل تعداد هر یک از انواع سؤالات مربوط 

به آن را تعیین کنید. هر یک از سؤالات در خط  زمان قابل ویرایش است.
4 سؤالات را وارد کنید.

روی اولین عبارت Type the Question here کلیک کنید تا اسلاید سؤال فعال شود و متن سؤال را وارد 
کنید. برای بقیه سؤالات هم این کار را انجام دهید.

با راست کلیک روی اسلاید سؤالاتی که قبلًا ایجاد کردید و انتخاب گزینه Move Question to می توانید 
سؤال خود را به طبقه بندی بانک سؤال اضافه کنید. 

شکل 29ـ کادر مدیریت بانک سؤال
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5 با توجه به شکل به تعداد دلخواه سؤال تصادفی ایجاد کنید.
سؤال تصادفی ایجاد شده فقط در زمان اجرای آزمون قابل مشاهده است.

فعالیت 
آزمون را طوری طراحی کنید که دارای بانک سؤال مطابق جدول 7 باشد و 5 سؤال تصادفی ایجاد کند. كارگاهي

برنامه را ذخیره کنید.

تعداد سؤال نوع سؤالنام منبع سؤال ردیف

5ترتیبیعربی 1 

4درست / نادرستعربی2 

2کلیک کردنیعربی3 

4جای خالیزبان خارجه4 

5چند گزینه ایزبان خارجه5 

انواع پروژه شامل  سؤال  بانک  جدید  پروژه  یک  در   » Snagit آموزش  الکترونیکی  » درس افزار  پروژه  برای 
سؤالات از آنچه که آموزش دیده اید ایجاد کنید سپس آزمون را طوری تنظیم کنید که در هربار اجرا 

نام »آزمون« ذخیره کنید.  با  را  10 سؤال به صورت تصادفی نمایش داده شود. پرونده 

شکل 30ـ ایجاد سؤال تصادفی

جدول 7ـ مشخصات منابع بانک سؤال



158

ارزشیابی مرحله 3

به نواری که در زمان پیش نمایش یا خروجی مشاهده می کنید و دارای دکمه های جلو، عقب، توقف، پخش 
صدا و ... است نوار کنترلی می گویند. بعضی از تنظیمات را روی نوار کنترلی می توان اعمال کرد. 

1 پروژه »ایران من« را نمایش دهید.
2  نوار کنترلی آن را بررسی کنید.

کارگاه 9    تغییر پوسته پروژه

درشکل 31 عملکرد هر یک از دکمه های روی نوار کنترلی پروژه را بنویسید. فعالیت 
كارگاهي

3 رنگ قسمت های مختلف نوار کنترلی را تغییر دهید.
به مسیر Project> Edit Skin وارد شوید. در بخش Playbar رنگ ها را مانند شکل 32 تغییر دهید.

شکل 31ـ نوار کنترلی پروژه

مراحل کار
 شرایط عملکرد

)ابزار، مواد، تجهیزات، زمان، مکان و ...(
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

ساخت آزمون 
تصادفی

مکان: کارگاه استاندارد رایانه 
تجهیزات: رایانه ای که نرم افزار تولید چندرسانه و 

Flash Player روی آن نصب باشد .
زمان: 15دقیقه

بالاتر از انتظار
ایجاد بانک سؤال با طبقه بندی های مختلف و درج انواع 
با سؤالات  – ساخت آزمون  سؤال در هر  طبقه بندی 

تصادفی
3

در حد انتظار
و درج  با طبقه بندی های مختلف  بانک سؤال  ایجاد 

انواع سؤال در هر  طبقه بندی 
2

پایین تر از 
حد انتظار

1ایجاد بانک سؤال با طبقه بندی های مختلف

پخش مجدد
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4 نوار کنترلی را به گونه ای طراحی کنید که همه 
دکمه های آن در وسط نوار قرار گیرد )شکل 32(.
5 با استفاده از گزینهBorder برای پروژه یک 

قاب ایجاد کنید.
6 پهنای قاب را 10 قرار دهید. 

7 پروژه را ذخیره کرده و نمایش دهید.

پس از اتمام کار در کپتیویت باید پروژه را برای اجرا 
و نشر آماده کرد.

شکل 32ـ تنظیمات پوسته

در صورتی که گزینه Playbar Two Rows را فعال کنیم چه تغییری ایجاد می شود؟كنجكاوي

فیلم
 فیلم شماره 10216 : ایجاد فهرست محتوا

فیلم را مشاهده کنید و فعالیت را انجام دهید.

Border
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فعالیت 
كارگاهي

فعالیت 
كارگاهي

پروژه

برای پروژه »ایران من« فهرست محتوا )TOC( ایجاد کنید.

در پروژه » درس افزار الکترونیکی آموزش Snagit « ، نوار کنترلی را به دلخواه تغییر دهید و برای پروژه 
خود فهرست محتوا ایجاد کنید. 

کارگاه 10   تولید و نشر پروژه

1 تنظیمات قبل از نمایش پروژه را انجام دهید. 
از منوی Edit گزینه Preferences را انتخاب کنید. جهت ساخت پروژه با اجرای خودکار)Autorun( در 
بخش Start & End گزینه Autoplay را انتخاب و در قسمت Preloader، یک پرونده swf را برای نمایش 

ابتدای پروژه انتخاب کنید.
2 در بخش Information اطلاعات خود را وارد کنید.

پرونده »نوروز« را برای استفاده در پروژه اصلی به صورت swf ذخیره کنید و به دکمه مربوطه در اسلاید 
گالری پیوند دهید. پرونده » مشاهیر ایران من « را نیز به صورت swf ذخیره و به دکمه مربوطه در اسلاید 

اصلی پیوند دهید. این مراحل را برای پرونده نظرسنجی تکرار کنید و از پروژه اصلی، خروجی بگیرید.

شکل 33ـ کادر گرفتن خروجی

گزینه های Video و Executable چه نوع خروجی تولید می کنند؟كنجكاوي

3 تنظیمات خروجی را انجام دهید.
از منوی File گزینه Publish as را انتخاب 
کنید. نوع خروجی را swf انتخاب کنید. عنوان 
پرونده  محل  کنید.  وارد   »Iran« را  خروجی 
را  پروژه  نمایش  کنید.  مشخص  را  خروجی 

تمام صفحه تنظیم کنید. به صورت 
 از پروژه خروجی بگیرید.  4

روی دکمه Publish کلیک کنید. 
5 پرونده خروجی را اجرا کنید.
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از پرونده های مختلفی که برای پروژه »درس افزار الکترونیکی آموزش Snagit « آماده کرده اید خروجی پروژه
swf بگیرید. برنامه های خروجی را به دکمه های مربوطه در پروژه اصلی پیوند دهید. پروژه را برای نشر 

آماده کنید و آن را تولید کنید.

مراحل کار
 شرایط عملکرد

)ابزار، مواد، تجهیزات، زمان، مکان و ...(
نتایج 
ممکن

نمرهاستاندارد )شاخص ها/داوری/نمره دهی(

تولید و نشر
 پروژه

مکان: کارگاه استاندارد رایانه 
تجهیزات: رایانه  مجهز به کارت صدا که نرم افزار 
آن  روی   Flash Player و  چندرسانه  تولید 

بلندگو باشد-  نصب 
زمان:10 دقیقه

بالاتر از حد 
انتظار

محتوا ـ   فهرست  ایجاد   - پروژه  پوسته  تغییر 
از  خروجی  گرفتن  محتوا-  فهرست  تنطیمات 

پروژه
3

در حد 
انتظار

تغییر پوسته پروژه - ایجاد فهرست محتوا -گرفتن 
خروجی از پروژه

2

پایین تر از 
حد انتظار

1تغییر پوسته پروژه ـ گرفتن خروجی از پروژه

 معیار شایستگی انجام کار:
کسب حداقل نمره 2 از مراحل ساخت آزمون الکترونیکی، تولید و نشر پروژه

 کسب حداقل نمره 2 از بخش شایستگی های غیر فنی، ایمنی، بهداشت، توجهات زیست محیطی و نگرش 
کسب حداقل میانگین 2 از مراحل کار

ارزشیابی مرحله 4

 سناریوی نشریه الکترونیکی » استان من « را بنویسید و با استفاده از پوسته گرافیکی نشریه استان من فعالیت منزل
که در فصل 2 طراحی کردید نشریۀ الکترونیکی خلاقانه ای برای استان خود تولید کنید.
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جدول ارزشیابی پایانی

شرح کار:

4  تولید و نشر پروژه  3  ساخت آزمون تصادفی             2  ساخت آزمون الکترونیکی            1  تنظیمات آزمون      

استاندارد عملکرد: 
با استفاده از نرم افزار تولید محتوا آزمون الکترونیکی با تنوع سؤال تولید کند. آزمون هایی با سؤالات تصادفی بسازد. مجموعه سازی کرده، پروژه تولید کند.

        شاخص ها:

شرایط انجام کار و ابزار و تجهیزات:
مکان : کارگاه رایانه مطابق استاندارد تجهیزات هنرستان ها

تجهیزات : رایانه  مجهز به کارت صدا که نرم افزار تولید چندرسانه و Flash Player روی آن نصب باشد- بلندگو
زمان : 60 دقیقه )تنظیمات آزمون 10دقیقه - ساخت آزمون الکترونیکی 20 دقیقه - ساخت آزمون تصادفی 15 دقیقه- تولید و نشر پروژه 10 دقیقه(

شماره 
شاخص های مرحله کارمرحله کار

1
انجام تنظیمات تعیین شده قبل از آزمونـ انجام تنظیمات تعیین شده بعد از آزمون در صورت قبولیـ انجام تنظیمات تعیین شده  بعد از آزمون 

در صورت عدم قبولی ـ ترجمه پیامهای بخش های مختلف آزمون

2
انتخاب نوع سؤال- درج سؤال و پاسخ - انجام تنظیمات تعیین شده سؤال- انجام تنظیمات تعیین شده کارنامه – تشخیص اطلاعات کارنامه – ایجاد 

پیش آزمون با مشخصات تعیین شده 

3
ایجاد طبقه بندی در بانک سؤال - درج انواع سؤالات تعیین شده در هر طبقه- اضافه کردن اسلاید سؤال موجود به طبقه بندی - ایجاد آزمون 

تصادفی- انتخاب تعداد سؤالات از طبقه های تعیین شده

4

تنظیم مشخصات تعیین شده پوسته - انتخاب نوع خروجی- ایجاد خروجی انتخاب شده با مشخصات تعیین شده – ایجاد فهرست محتوا- تعیین 
عنوان اسلایدهای فهرست محتوا- نمایش فهرست محتوا روی اسلایدها- انجام تنظیمات تعیین شده نمایش فهرست محتوا روی اسلایدها- فعال 
کردن امکان جستجو در فهرست محتوا- فعال کردن علامت گذاری اسلایدهای مطالعه شده- انجام تنظیمات نمایش اسلایدها بر اساس زمان – 

انتخاب Theme فهرست محتوا

نمره هنرجوحداقل نمره قبولی از 3مرحله کارردیف

1تنظیمات آزمون1

2ساخت آزمون الکترونیکی2

1ساخت آزمون تصادفی3

2تولید و نشر پروژه4

شایستگی های غیرفنی، ایمنی، بهداشت، توجهات زیست محیطی و نگرش:
کنترل کیفیت ـ تفکر خلاق – به کارگیري فناوري مناسب ـ مدیریت زمان ـ نقش در گروه ـ جمع آوری و گردآوری 

اطلاعات ـ مدیریت کارها و پروژه ها ـ زبان فنی
رعایت ارگونومي – کنترل حفاظتي الکتریکي و الکترونیکي )ابزار و تجهیزات(

 ایجاد محتوای الکترونیک ـ کاهش مصرف کاغذ ـ دقت در محافظت از سؤالات آزمون

2

*میانگین نمرات

* حداقل میانگین نمرات هنرجو برای قبولی و کسب شایستگی، 2 است.

معیار شایستگی:
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فصل 4

حل مسائل ساده

روبه رو  بسیاری  بزرگ  و  کوچک  مسائل  با  کار،  و  کسب  محیط  و  روزمره  زندگی  در 
می شویم. آگاهی از روش  ها و فنون حل مسئله به ما در رویارویی و غلبه بر مسائل کمک 
نظام مند  ، ممکن است سخت،  از روش های  بهره گیری  بدون  می کند. حل یک مسئله 
پیچیده، زمان بر، غیرمنطقی و حتی گاهی بی پاسخ به نظر برسد. همیشه با پیدا کردن 
راه حل یک مسئله  ، حل آن به پایان نمی رسد. در برخی مسائل بزرگ، یافتن راه حل برای 
انسان نیز به نظر سخت، طولانی و خسته کننده و مستعد اشتباه است  . اما می توان از 
سرعت، دقت و خستگی ناپذیری رایانه بهره جست و با تبدیل کردن راه حل به دستورات 
قابل فهم برای رایانه، انجام راه حل را به رایانه سپرد  . در این فصل هنرجو قادر خواهد 
دستورات  استودیو،  ویژوال   IDE با  کار  مسئله،  مهارت حل  و  دانش  بر  اتکا  با  تا  بود 
دریافت  ، نمایش مقادیر و تبدیل داده کار با عملگرهای منطقی و دستورات شرطی ساده 
با خروجی های  کنسول  سادۀ  برنامه های  برنامه نویسی سی شارپ،  بستر  در  پیچیده ،  و 

جذاب تولید کند.
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 برای حل یک مسئله چه مراحلی باید طی شود؟
 برای رسم روندنمای یک مسئله از چه نرم افزاری می توان استفاده کرد؟

 IDE چیست و چه کاربردی دارد؟
  در زبان سی شارپ دستورات چگونه از یکدیگر تفکیک می شوند؟ 

  چگونه می توان در زبان سی شارپ خروجی های جذاب همراه صدا تولید کرد؟

هدف از این واحد شایستگی، چگونگی حل مسئله و کار با بخش های مختلف IDE و ایجاد برنامه های کنسول 
ساده برای نمایش خروجی های ساده و جذاب است.

آیا تا به حال پی برده اید

استاندارد  عملکرد

با دانش   حل مسئله، راه حل و الگوریتم ارائه دهد و از محیط IDE برای ایجاد برنامه های ساده کنسول برای 
تولید خروجی های جذاب استفاده کند.

واحد یادگیری 7 

 IDE شایستگي حل مسئله و کار با
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با هم کلاسی خود، درباره مراحل انجام یک خرید اینترنتی گفتگو کنید.

1ـ شتاب سرواژه عبارت شبکه تبادل اطلاعات بین بانکی است.

)Problem Solving( حل مسئله
در یک جامعه پیشرفته، بسیاری از روش های سنتی با روش های نوین جایگزین شده اند که از فناوری های روز 
دنیا بهره می گیرند. خرید اینترنتی و پرداخت الکترونیکی یکی از این روش های جدید است و آشنایی با آن 

در دنیای امروز بسیار اهمیت دارد. اما خرید اینترنتی چگونه است؟
ابزار اصلی خرید اینترنتی، وجود یک کارت بانکی                           است. در ایران بیشتر بانک  ها عضو شبکه شتاب1 هستند؛ 
بنابراین داشتن کارت یکی از این بانک  ها امکان استفاده از خدمات گسترده این شبکه را فراهم می سازد. با مراجعه 
به فروشگاه                          های اینترنتی                           که از درگاه پرداخت الکترونیک شتاب استفاده می                          کنند، می توانیم از خدمات خرید 

اینترنتی استفاده کنیم. 

درباره روش های تولید کد امنیتی )کپچا( تحقیق کنید.پژوهش

فعالیت 
گروهی

فعالیت 
در مورد دلایل استفاده از صفحه کلید مجازی در زمان خرید اینترنتی با هم کلاسی خود بحث کنید .گروهی

اولین گام حل مسئله شناخت مسئله است. در این مرحله تعیین می کنیم: 
1 چه داده هایی داریم؟ پاسخ این سؤال، ورودی های مسئله است.  

2 چه اطلاعاتی را می خواهیم به دست آوریم؟ پاسخ این سؤال خروجی های مسئله است.
گام بعدی حل مسئله طرح نقشه است. که در این گام مسیر رسیدن از ورودی به خروجی را تعیین می کنیم.

تولیدکننده  نرم افزاری بخرد . شرکت  نرم افزار، بسته  تولید  از یک شرکت معتبر  آقای خوش نام قصد دارد   
نرم افزار در نقطه ای از شهر قرار گرفته که بار ترافیکی بسیار سنگینی دارد و دسترسی به آن وقت و حوصله 
زیادی می طلبد. با مراجعه به تارنما شرکت، متوجه گزینه خرید اینترنتی می شود. در خرید اینترنتی، پس از 
انتخاب نرم افزار از لیست محصولات شرکت و پرداخت هزینه، نرم افزار از طریق پست، به نشانی خریدار ارسال 

خواهد شد.  در فرایند خرید اینترنتی اطلاعات زیر مورد نیاز است:
1 شماره                                                      کارت

2 رمز خرید اینترنتی یا رمز دوم کارت
CVV2 3

4 تاریخ انقضای کارت
5 ایمیل

6 کد امنیتی یا کپچا
پس از ورود این اطلاعات و تکمیل فرایند خرید، کد رهگیری پرداخت تولید شده، نمایش داده می شود.
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فعالیت 
كارگاهي

مسئله 1: برای خرید اینترنتی جدول حل مسئله را تکمیل کنید.

شناخت مسئله
شماره کارت، رمز دوم ......ورودی ها

کد رهگیری پرداختخروجی ها

الگوریتم

شروع
1  وارد کردن شماره کارت بانکی

  2

3  پایان

مسئله 2: برای یک سامانه ورود و خروج کارمندان که براساس اثر انگشت کار می کند، جدول زیر را کامل 
کنید.

شناخت مسئله
ورودی ها

خروجی ها

الگوریتم

شروع
1  لمس کردن مکان مخصوص اثر انگشت

2  اگر کاربر مجاز است، در باز شود
    در غیر این صورت در باز نشود

3  پایان

 سامانه های مسئله 1و2 را از لحاظ ورودی، خروجی و پردازش مقایسه کنید.
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شکل 1ـ توربین بادی

شناخت مسئله
ورودی ها

خروجی ها

الگوریتم

شروع
1  وزش باد

2  چرخش توربین بادی
3  تولید انرژی الکتریکی

4  اگر تولید انرژی الکتریکی از طریق توربین کافی بود، وارد شبکه خانگی شود
در غیر این صورت از شبکه توزیع برق شهری استفاده کند

5  پایان

شکل 2ـ سلول خورشیدی

مسئله 3: انرژی های تجدیدپذیر 
انرژی های  تصاویر  به  توجه  با 
تکمیل  را  زیر  تجدیدپذیر، جداول 

. کنید
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شناخت مسئله
تابش خورشیدورودی ها

الکتریسیتهخروجی ها

الگوریتم

شروع
.......... 1
.......... 2

سامانه تولید انرژی های تجدیدپذیر شامل چندین زیر سامانه است که هر کدام کار مجزایی برای یک هدف 
مشخص انجام می دهند. همان طور که در تصویر مشخص است خروجی یک سامانه، ورودی سامانه دیگری 

است. اطلاعات خواسته شدۀ جدول زیر را تکمیل کنید.

سامانه استفاده کننده خروجی سامانه تعیین کننده ورودیسامانه ردیف

مبدلسلول خورشیدی1

سلول خورشیدیمبدل2

واحد اندازه گیری3

مسئله 4: نگین و باران هر دو کوچک هستند و نمی توانند روی پاهای خود بایستند. نگین روی صندلی قرمز 
و باران روی صندلی آبی نشسته است. بچه  ها می خواهند صندلی خود را عوض کنند. مادر بچه  ها در خانه تنها 

است. الگوریتم زیر را طوری  کامل کنید که مادر شان بتواند جای بچه ها را با یکدیگر عوض کند  )شکل3(.

شناخت مسئله
ورودی ها

خروجی ها

الگوریتم

1 شروع
blankChair ← redChair 2
redChair ← blueChair 3

.......... 4
5 پایان

 

محدودیت مسئله نشان می دهد نگین و باران نمی توانند روی پای خود بایستند. با وجود این چه راه حلی كنجكاوي
به ذهن شما می رسد؟ روبه روی شکل 3 بنویسید.
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شکل 3ـ جابه جایی 

نماد استاندارد برای ترسیم روندنما را در محل های آن رسم کنید. فعالیت 
كارگاهي

الگوریتم، یکی از روش های حل گام به گام مسئله است و روند نما جریان کاری الگوریتم را به تصویر می کشد. 
در حل مسائل به کمک الگوریتم، می توانیم از روندنما استفاده  کنیم.

ورودی ـ خروجی شرط

عملیات مسیر اجرا شروع و پایان

............... 2  ............... 1  

............... 3  ............... 4  
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مسئله 5: اگر سن دو نفر را داشته باشیم، روندنمای زیر را طوری تکمیل کنید که سن فرد بزرگتر را نمایش 
دهد.

شناخت مسئله
ورودی ها

خروجی ها

روندنما

 
مسئله 6: روندنمای طراحی شده را طوری تکمیل کنید که اندازه قد سه نفر را از ورودی گرفته، آنها را به 

صورت نزولی یعنی از بزرگ به کوچک مرتب کند )شکل 4(  .

شناخت مسئله
ورودی ها

خروجی ها

روندنما

سن دو نفر را وارد کنید

y = tx = yt = x
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مسئله 7: هر رایانه رومیزی از موادی که در جدول 
روبه رو آمده، تشکیل شده است.

کیلوگرم   9 رومیزی حدود  رایانه  هر  اینکه  فرض  با 
هنرستان شما چندگرم  رایانه  کارگاه  در  دارد،  وزن 

نقره وجود دارد؟ و  طلا 

شکل 4ـ مرتب سازی 

فعالیت 
كارگاهي

برای سه ورودی با ترتیب های مختلف روندنما را 
اجرا کرده، درستی آن را بررسی کنید.

شناخت مسئله
تعداد رایانه های کارگاهورودی ها
میزان طلا و نقره برحسب گرمخروجی ها

روندنما

درصدقطعهردیف

32پلاستیک1
7سرب2
41آلومینیوم3
0/61طلا4
0/2آهن5
0/981نقره6
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فعالیت 
كارگاهي

فعالیت 
كارگاهي

RAPTOR نرم افزار
نرم افزار RAPTOR ابزاری قدرتمند برای ترسیم و بررسی روندنما در رایانه است که قابلیت های زیادی دارد:

 روندنما را در فایلی با پسوند rap ذخیره می کند.
 روندنما را به زبان سی شارپ و برخی زبان های دیگر ترجمه می کند.

 سرعت اجرا را کاهش می دهد تا روند اجرا قابل مشاهده باشد.
 امکان اجرای مرحله به مرحله دارد.

نمایش  را  حافظه  در  متغیرها  تغییرات   
. می دهد

بیتی   64 به صورت  نرم افزار  این  برای نصب 
.را  نصب   Net     Framework باید ابتدا  5  .3  

. کنید

 داده های غیر مرتبط مسئله 7 را بنویسید.
.......................................................................................................................................................................................

با استفاده از نرم افزار RAPTOR و با راهنمایی هنرآموز روندنما شکل 3 را ترسیم کرده، آن را اجرا 
کنید.

 شکل 5 بیان حل چه مسئله ای است؟كنجكاوي

برخی از داده های این مسئله، برای به دست آوردن خروجی به ما کمکی نمی کنند و زائد هستند. بنابراین 
داده های مسئله به دو دسته مرتبط و غیر مرتبط تقسیم بندی می شوند. داده های مرتبط در روند اجرای مسئله 

تأثیر دارند؛ ولی داده های غیر مرتبط تأثیری بر نتیجه خروجی و الگوریتم حل مسئله نخواهند داشت.

RAPTOR شکل5 ـ نرم افزار
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 ارزشیابی مرحله 1

شایستگی ها
 شرایط عملکرد

)ابزار،مواد، تجهیزات، زمان، مکان و ...(
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

شایستگی های 
غیرفنی

مسئولیت پذیری ـ  تصمیم گیری ـ تفکر خلاق ـ 
جمع آوری و گردآوری اطلاعات ـ نقش در گروه  ـ 

قابل قبولزبان فنی

حفاظت از تجهیزات کارگاه ـ انجام وظایف محوله 
ـ  مسئله  برای  خلاقانه  راه حل  ارائه  ـ  گروه  در 
بازگرداندن تنظیمات IDE به تنظیمات اولیه پس 

2از استفاده از آن ایمنی و بهداشت
الکتریکی و  رعایت ارگونومی ـ کنترل حفاظتی 

تجهیزات( و  )ابزار  الکترونیکی 

توجهات
 زیست محیطی

ترسیم روندنمای الکترونیکی کاهش مصرف 
کاغذ

توجه به ایمنی و بهداشت محیط کارگاهغیر قابل قبول
1 نگرش

و  زندگی  روزمره  مسایل  در  مسئله  حل  کاربرد 
نوآوری و  ایجاد خلاقیت  ـ  کار 

آنچه آموختم:

......................................................................................................................................................................................  1

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

برداشت

جدول ارزشیابی شایستگی های غیرفنی، ایمنی و بهداشت و توجهات زیست محیطی

مراحل کار
 شرایط عملکرد

)ابزار، مواد، تجهیزات، زمان، مکان و ...(
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

حل مسئله

مکان: کارگاه استاندارد رایانه 
تجهیزات: کاغذ- نوشت افزار- رایانه ای که نرم افزار 

رسم روندنما روی آن نصب باشد  .
زمان: 15 دقیقه

بالاتر
 از حد انتظار

تعیین داده، اطلاعات ورودی و خروجی در مسئله ـ 
ارائۀ راه حل برای مسئله ـ ترسیم روندنما به صورت 

دستی و با نرم افزار
3

در حد انتظار
در  خروجی  و  ورودی  اطلاعات،  داده،  تعیین 
مسئله – ارائه راه حل برای مسئله – ترسیم روندنما 

2به صورت دستی 

پایین تر از 
حد انتظار

در  خروجی  و  ورودی  اطلاعات،  داده،  تعیین 
1مسئله 
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فعالیت منزل

آشنایی با زبان سی شارپ
از  دشوارتر  و سخت افزار،  ماشین  زبان  به  نزدیکی  علت  به  میانی  و  پایین  زبان های سطح  به  برنامه نویسی 
است. نزدیک  محاوره ای  زبان  به  و  است  بالا  زبان های سطح  از  زبان سی شارپ  است.  بالا  زبان های سطح 

زبان برنامه نویسی سی شارپ در سال 2000 با نام تجاری #C  انتشار یافت. این زبان از خانواده زبان های 
ویندوز  برای  که  می کند  استفاده   .NET نرم افزاری لایه  از   C# زبان  است.   .NET Framework بر    پایه 
طراحی شده است. اگر بخواهیم روی سیستم عامل دیگری برنامه سی شارپ را اجرا کنیم، باید لایه نرم افزاری 

مطابق با NET . روی آن سیستم نصب شود.

 آشنایی با ویژوال استودیو

Integrated Development Environment) IDE( محیط های نرم افزاری توسعه یافته و یکپارچه  است. 
IDE هایی که برای برنامه نویسی استفاده می شوند، نرم افزارهایی هستند که ابزارهای مورد نیاز مانند ویرایشگر 
برنامه، مترجم، اشکال زدایی و ... را به صورت یکپارچه برای برنامه نویس فراهم می سازند. در این کتاب از نسخه 
برنامه نویسی   IDE استفاده می کنیم که محیط   Visual Studio Express 2012 for Desktop رایگان 

مایکروسافت است و آن را به اختصار VS می نامیم. 

ADA شکل 6ـ اولین الگوریتم نوشته شده به وسیله نخستین برنامه نویس جهان خانم

نرم افزار ویژوال استودیو را روی رایانه شخصی خود نصب کنید.

فیلم نصب نرم افزار ویژوال استودیو را مشاهده کرده، فعالیت زیر را انجام دهید.

فیلم شماره 10222 : نصب نرم افزار ویژوال استودیوفیلم
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 برنامه VS را از مسیر زیر اجرا کنید. 1
...\Programs\Microsoft Visual Studio 2012 Express

 پروژه جدید ایجاد کنید. 2
 OK برای ایجاد پروژه مطابق مراحل درج شده در شکل 7 عمل کرده، پس از نام گذاری پروژه روی دکمه

کلیک کنید.

کارگاه 1    ایجاد اولین برنامه در سی شارپ

شکل 7ـ ایجاد پروژه

 بخش های 4( Name(، Location )5( و Solution name )6( را با دقت تنظیم کنید. در نام گذاری پروژه 
از اسم مناسب استفاده کنید تا دسترسی  به پروژه ساده شود. )شکل 7( نام این برنامه را FirstProgram قرار 

دهید.
در این کتاب برنامه نویسی در مد Console Application انجام می شود. برنامه های نوشته شده در این 
مد، برنامه کنسول نامیده می شوند. در برنامه کنسول امکان استفاده از واسط های گرافیکی )GUI( وجود 
ندارد. ورودی  ها و خروجی های برنامه کنسول در پنجره خط فرمان )Command Prompt( قرار می گیرند. 
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شکل 9ـ یک برنامه ساده درسی شارپ

شکل 9 الگوی یک برنامه ساده در سی شارپ را نشان می دهد. در این الگو using,namespace,class,static,void و 
string کلید واژه های سی شارپ هستند و با رنگ یکسان مشخص می شوند. البته نگران نباشید، با ایجاد یک پروژه، 

سی شارپ الگو را در اختیار برنامه نویس قرار   می دهد. بنابراین نیازی به حفظ کردن آنها ندارید.

GUI شکل 8ـ مقایسه دو نوع

دو تصویر شکل 8  را با هم مقایسه کنید. تصویر نمایشگر کدام تلفن همراه با استفاده از واسط گرافیکی 
طراحی شده است؟

كنجكاوي
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الگوی شکل 10 متد Main که نقطه  مطابق 
داخل  در  است،  سی شارپ  برنامه های  شروع 
نام  فرض  پیش  صورت  به  دارد.  قرار  کلاس 
است. فضای  یکسان  پروژه  نام  با  نامی،  فضای 
شامل  که  است  مدرسه  فضای  مشابه  نامی 
چندین کلاس است، کلاس های مدرسه مشابه 
کلاس در سی شارپ است و فعالیت های درون 

هستند. متد  ها  همان  کلاس 

3 در پنجره ویرایشگر برنامه دستور زیر را وارد کنید.
 Console.WriteLine("in the name of god"); 
در این دستور از متد WriteLine بـرای نمایش پیام در صفحه خـروجی استفاده شده است. ایـن متد در 

کلاس کنسول )Console( قرار دارد.کلاس کنسول از کلاس های آماده سی شارپ است. 

شکل 11ـ نمونه ای از فضای نامی کلاس و متد در دنیای واقعی 

شکل 10ـ الگوی یک برنامه سادۀ سی شارپ

می
ی نا

ضا
ف

کلاس
متد

 به حروف کوچک و بزرگ در این دستور توجه کنید. چه تفاوت هایی می بینید؟كنجكاوي
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5 بار دیگر برنامه را با کلید F5 اجرا کنید.
خروجی،  پنجره  مشاهده  و  برنامه  توقف  برای  می شود؛  بسته  بلافاصله  کنسول  پنجره 
کنید.  اجرا  را  برنامه  کرده،  اضافه  برنامه  انتهای  در  را   Console.ReadKey دستور; )  ) 

static void Main)string[] args)
 {

Console.WriteLine("in the name of god ");
Console.ReadKey));

 }

متد  )  ) ReadKey برای دریافت کلیدی از صفحه کلید به کار می رود. این متد سبب توقف برنامه تا فشردن 
یک کلید می شود و به کاربر اجازه مشاهده خروجی را می دهد. این متد در کلاس کنسول قرار دارد.

Debug شکل 12ـ منوی

زبان سی شارپ به حروف کوچک و بزرگ حساس )Case sensitive( است. 

)Error List( کارگاه 2  پنجره لیست خطا

 پروژه کارگاه FirstProgram( 1( را باز کنید . 1
 برای بازکردن مجدد پروژه می توانید در پوشه پروژه روی فایل با پسوند sln دابل کلیک کنید)شکل 13(.

شکل 13ـ پوشه پروژه

 با استفاده از کلید Ctrl+ F5 برنامه را اجرا  4
کرده، خروجی را مشاهده کنید.

فیلم
IDE فیلم شماره 10223: آشنایی با 

یادداشت
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 در متد Main، کلاسConsole را به شکل Console بنویسید و برنامه را اجرا کنید. 2

3 علامت; را از انتهای دستور WriteLine و Readkey حذف کنید )شکل 15( .

شکل 14ـ کادر پیام وجود خطا

شکل 15ـ  فهرست خطاها

ـ خطای نمایش داده شده را ترجمه کنید )شکل 15(.كنجكاوي
ـ ستون های Description, File, Line, Column و Project در پنجره خطا چه چیزی را نشان 

می دهد.

ـ پیام خطای ظاهر شده را ترجمه کنید. )شکل 14(كنجكاوي
ـ روی دکمه No کلیک کنید و خطای ایجاد شده را به کمک هم کلاسی خود ترجمه کنید.
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 در پنجره لیست خطا روی یکی از خطا  ها کلیک کنید. 4
این پنجره خطاهای زمان ترجمه را مشخص می کند. با دابل کلیک روی هرخطا، خطی از برنامه که خطا در 

آن رخ داده، نشان داده می شود. با رفع هر خطا در برنامه، لیست خطاها به روز رسانی می شود.

ارزشیابی مرحله 2

 شرایط عملکردمراحل کار
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن)ابزار، مواد، تجهیزات، زمان، مکان و ...(

شناسایی IDE و 
اجزای آن

مکان: کارگاه استاندارد رایانه 
استودیو  ویژوال  نرم افزار  که  رایانه ای  تجهیزات: 

باشد روی آن نصب 
زمان: 10 دقیقه

بالاتر
 از حد انتظار

ایجاد ذخیره و بازیابی پروژه کنسول ـ تایپ سریع 
Snippets و Intellisense 3کد با استفاده از

در حد انتظار
 ایجاد پروژه کنسول ـ ذخیره و بازیابی پروژه ـ به کارگیری 

IDE و اجزای آن در ایجاد یک برنامه کنسول
2

پایین تر از حد 
انتظار

1ایجاد پروژه کنسول ـ ذخیره و بازیابی پروژه

آنچه آموختم:

......................................................................................................................................................................................  1

.....................................................................................................................................................................................     

...................................................................................................................................................................................... 2
.....................................................................................................................................................................................    
...................................................................................................................................................................................... 3
.....................................................................................................................................................................................    

برداشت

در انتهای دستورات سی شارپ باید علامت; قرار داده شود.
یادداشت
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 پروژه جدیدی با نام Screen ایجاد کنید. 1
 کد زیر را در Main وارد کنید. 2

 Console.Write)"I ");
 Console.Write)"like ");
 Console.Write)"C#"); 

3 برنامه را اجرا کرده، خروجی آن را یادداشت کنید.
 کد قبلی را پاک کرده، کد زیر را جایگزین کنید. 4

 Console.WriteLine("I ");
 Console.WriteLine("like ");
 Console.WriteLine("C#");

برنامه را اجرا کرده، خروجی آن را با کد قبلی مقایسه کنید.
 برنامه را پاک کرده، قطعه کد زیر را وارد کنید. 5

برای نوشتن دستور Console.WriteLine، می توانید cw را تایپ کرده و سپس کلید tab را دوبار فشار دهید.
برنامه را اجرا کرده، نتیجه را با مرحله 4 مقایسه کنید.

 Console.WriteLine("I ");
 Console.WriteLine((;
 Console.WriteLine("like ");
 Console.WriteLine((;
 Console.WriteLine("C#");

 در قطعه کد مرحله 5 دستور WriteLine را به Write تبدیل کنید.  6
 برنامه را اجرا کرده، نتیجه را با مرحله 5 مقایسه کنید. 7

WriteLine و Write کارگاه 3  تفاوت متد های

آنچه آموختم:

......................................................................................................................................................................................  1

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

برداشت

دستور )( write را نمی توان بدون پارامتر ورودی به کار برد.
یادداشت
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نمایش فهرست هوشمند

از این پنجره برای نوشتن کد های برنامه استفاده می شود )شکل 16(. این محیط دارای ویژگی هایی برای 
سرعت بخشیدن به فرایند برنامه نویسی است. باز شدن خودکار فهرست هوشمند)Intellisense( که برای 
این  باز شدن  برای  است.  این محیط  قابلیت های  از  قرار می گیرد،  استفاده  مورد  و سریع تر  نوشتن صحیح 

استفاده کرد.   Ctrl+Space ترکیبی  از کلید  فهرست می توان 

متد Beep برای ایجاد یک صدا در برنامه استفاده می شود. شکل کلی این دستور به صورت زیر است:
  Console.Beep ) مدت زمان برحسب میلی ثانیه، فرکانس برحسب هرتز(

 پروژه جدیدی با نام Melody ایجاد کنید. 1
 برنامه زیر را در Main وارد کنید. 2

Console.WriteLine("I");
Console.Beep)200, 800);
Console.WriteLine("like");
Console.Beep)200, 800);
Console.WriteLine("C#");
Console.Beep)200, 800);

شکل 16ـ فهرست هوشمند

کارگاه 4  ایجاد صدا با فرکانس های مختلف

فعالیت
با هم گروهی خود پیام های دیگری با استفاده از دستورات Write و WriteLine در خروجی بنویسید.گروهی
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فعالیت 
كارگاهي

فعالیت 
كارگاهي

با کم و زیاد کردن اعداد ورودی های متد Beep روشی را برای زیر و بم کردن صدا پیدا کنید.

قطعه برنامه زیر را با فرکانس و مدت زمان های داده شده کامل کنید و از شنیدن موسیقی که نوشته اید، 
لذت ببرید. برای ادامه موسیقی از هنرآموز خود کمک بگیرید.

 Console.Beep)370, 600);
 Console.Beep(550, 600(;
 Console.Beep)370, 600);

54321

(590,600()490, 300)(590, 600((590, 300((550, 600(

(550,600()660,300)(550, 600((550,1200((550,300(

)490,600)(550,1200()490, 300))700, 600)(590, 300(

 )440,300))370,600))440, 300))660, 600))660, 300)

3 برنامه را اجرا کنید.
 اعداد درون دستور ;) , ( Console.Beep را به دلخواه تغییر دهید و برنامه را اجرا کنید. 4

 اعداد درون متد را حذف کنید و برنامه را اجرا کنید.  5
خروجی با مرحله قبل چه تفاوتی دارد؟

توجه داشته باشید مقدار فرکانس را باید در محدوده مناسبی بنویسید زیرا گوش انسان تنها قادر است اصواتی 
با فرکانس حدود 200 تا 10000 هرتز را بشنود. صداهای بم فرکانس کم و صدا های زیر فرکانس بالا دارند.

آنچه آموختم:

......................................................................................................................................................................................  1

...................................................................................................................................................................................... 2

...................................................................................................................................................................................... 3

برداشت
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در این برنامه می خواهیم متن های محیط کنسول را با رنگ های مختلف چاپ کنیم.
 پروژه جدیدی با نام color1 ایجاد کنید. 1

 کد زیر را در Main وارد کنید. و برنامه را اجرا کنید. 2
 Console.ForegroundColor = ConsoleColor.Blue;

 Console.WriteLine(" ");

 Console.ForegroundColor = ConsoleColor.Red;

 Console.WriteLine(" ");
3 نام و نام خانوادگی خود را به ترتیب در دستور WriteLine اول و دوم قرار دهید و دوباره برنامه 

را اجرا کنید. 
تفاوت خروجی مرحله 2  و 3  چیست؟

 برنامه را به شیوه زیر تغییر داده، دوباره اجرا کنید. تفاوت آن با مرحله قبل چیست؟ 4
 Console.BackgroundColor = ConsoleColor.Blue;

 Console.Clear));

 Console.ForegroundColor = ConsoleColor.Red;

 Console.WriteLine("ali");

 در انتهای کد مرحله 4 دستور; )(Console.Clear را بنویسید و برنامه را اجرا کنید تفاوت آن  5
با مرحله قبل چیست؟

مراحل کار
 شرایط عملکرد

)ابزار، مواد، تجهیزات، زمان، مکان و ...(
نمرهاستاندارد )شاخص ها/داوری/نمره دهی(نتایج ممکن

نوشتن 
برنامه های ساده

مکان: کارگاه استاندارد رایانه 
تجهیزات: رایانه مجهز به کارت صدا که نرم افزار 

ویژوال استودیو روی آن نصب باشد
زمان: 15 دقیقه

بالاتر از انتظار
و  ساده  تصویری  خروجی های  با  برنامه  ایجاد 
با  برنامه  ایجاد  صفحه نمایش ـ  روی  پیچیده 

معنادار صوتی  خروجی 
3

در حد انتظار
ایجاد برنامه با خروجی های تصویری ساده روی 

صفحه نمایش ـ ایجاد برنامه با خروجی صوتی
2

پایین تر از حد 
انتظار

ایجاد برنامه با خروجی های تصویری ساده روی 
صفحه نمایش

1

ارزشیابی مرحله 3

کارگاه 5  استفاده از رنگ 


